
 American History Explorer Help Contents 

Welcome to the American History Explorer for Windows Online Help system! Here you'll find 
information on operating the program and accessing features through the menus and buttons. This help 
system has been divided into the topics below to make it as easy as possible to use.

In addition, you may wish to click on the Product Support button below for information on reaching our 
Customer Service and Technical Support teams:

 

If you don't find the topic you want on these buttons, click the  

button above to locate a more specific topic. You can also use the browse buttons  to 
quickly scan the available topics. At any time you can return to this screen by clicking the 

 button. The topics are linked so that you can move quickly from one topic to another by clicking
icons or underlined words. 



 Basic Information

As you begin working with American History Explorer, you may find it helpful to understand the 
following topics. Just click on any underlined title to access information on that topic.

Program Tour 
Features of the Opening Screen 
Screen Elements 
Finding Help
Closing Screens 
Exiting the Program 

Program Copyrights 
Using Copyrighted Material 
Bibliography 
For more information see:
Summary of Menus 
Navigating the Program 



 Summary of Menus

The following is a summary of the functions available from menu bars available in American History 
Explorer. Menu bars are available from Map windows and Article windows (but only if you used the 
Read/Write installation option). For more information about a particular menu, click on the appropriate 
menu name.

Map Windows
Map--Create a new map; open an existing map; save, copy, and close a map; delete a map you've added;
view a slide show; modify the print setup for maps; and print a map.

Edit--Copy maps to the Windows Clipboard; create, edit, place, move, and delete items on a map; change
the background for a map; merge two maps; access the Toolbox to create and manipulate graphics for a 
map; and edit the map's legend.

Articles--Display Overview, People, and Document articles associated with the current map and associate
articles with the current map.

Search--Open the Place/Names dialog which you can use to locate historic places, names, and events 
that are on the current map, (or other maps); select an item to add to the map, and perform a variety of 
other search and display options.

Options--Display or hide the map legend, and zoom in or out on a map.

Help--Access online Help for information on program operations and product support, as well as 
information about American History Explorer and the Settings dialog.

Article Windows
Article--Create articles; open an existing article; save, copy, and close articles; delete articles you've 
added to the program; modify the print setup for articles and print an article.

Edit--Undo the last action, cut and copy selected text from an Article window into the Windows Clipboard 
(for use in an article or a word processor), paste text from the Windows Clipboard into an article, select all
text within an Article window; find a word or phrase within the current article and repeat a "find" search, 
and place an article in the Edit mode.

Links--Return to the previous article viewed or jump to the next article viewed in a series of linked articles;
link and unlink articles.

Font--Modify the font of text used in all articles, or customize selected text in the current article with bold, 
italic, or underlined text.

Help--Access online Help for information on program operations and product support, as well as basic 
information about American History Explorer and the Settings dialog box.

For more information see:
Screen Elements 
Icon Bar
Navigating the Program 
Moving Text to Word Processors 



 Navigating the Program

Although American History Explorer is a sophisticated, fact-packed program, we think you'll find it easy 
to use. 

From most features, you can just click your mouse button when the cursor on screen points to the item 
you want.

When working with maps and articles, you'll operate in Map windows or Article windows, using basic 
Microsoft Windows operations. Many other features are accessed by using dialog boxes.

In most instances, you'll see a pointer style cursor. When the cursor changes to a hand cursor it indicates 
that you're over a "hot spot" in the program. Clicking on a hot spot accesses a program feature. (When 
adding your own graphics to a map, you may select the hand cursor tool to select and move graphics.) At 
various other points in the program, your cursor will turn to a solid arrow, indicating that you can scroll left 
or right by simply bumping the cursor against the edge of the screen while holding down the left mouse 
button.

Select topics in the list below for assistance in moving around the program. You may also find it helpful to 
review your Windows User's Guide, since American History Explorer uses many Windows features.

Selecting Items and Using Buttons
Entering Data 
Using Dialog Boxes 
Closing Screens 
For more information see:
Screen Elements 
Searching in American History Explorer 
Working with Articles    
Working with Maps 
Working with Pictures 
Playing Movies and Slide Shows
Playing Songs and Games 
Scrolling Forward and Backward in Time Lines 
Printing 
Optional Settings 
Summary of Menus 
Exiting the Program 



  Searching in American History Explorer

There are several ways to "explore" the information in this program. You can search for data in several 
ways, depending upon the information you need. For example, 

To find any word in the American History Explorer database, click the Finder icon on the 
Opening Screen.

To find a specific article, click the Source Book icon on the Opening Screen, or if you already 
have an Article window open, choose Open from the Article menu or click on the Open Article icon on the 
icon bar.

To find a specific map, click the Map Studio icon on the Opening Screen, or if you already have a 
Map window open, choose Open from the Map menu or click on the Open Map icon on the icon bar.

To find items, such as cities, battle sites, and famous people associated with a map, use the 
Find/Select Items option under the Search menu of the Map window or click on the Search icon on the 
icon bar.

To find information about U.S. presidents, click the Hall of Presidents icon on the Opening 
Screen. 

To find any picture, click the Picture Album icon on the Opening Screen.
To find a specific slide show, click the Slide Shows icon on the Opening Screen. 
To find a 3D picture to view, click the 3D Gallery icon on the Opening Screen. 

To find a video to view, click on the Movie Theater icon on the Opening Screen.

To find a time line of a historic period, click on the Time Trek icon on the Opening Screen.

To find music from the Colonial or Civil War periods, click on the Song Book icon on the Opening 
Screen.

To find questions for testing over information in the American History Explorer, click on the 5Ws
Game icon on the Opening Screen.

For more information see:
Using Dialog Boxes 
Finder 
Source Book 
Map Studio 
Map Search Menu 
Searching for Map Items 
Selecting Items and Using Buttons 
Hall of Presidents 
Slide Shows 
Picture Album 
3D Gallery 
Movie Theater 
Time Trek 
Song Book 
5Ws Game 



 Working with Articles

Perhaps the most fascinating aspect of the American History Explorer is the extensive collection of 
articles it contains, providing full historical information and insight into the maps and the historic events 
associated with them. 

You can access the articles directly, or while working with other program features such as maps or a time 
line. Use the articles to learn more about the maps, or as a "mini reference library." 

If you choose the Read/Write installation option, you can also edit the articles included with the program 
and even create your own articles to supplement your "library." When finished, you can associate your 
articles with maps and/or items contained on a map.

The topic list below outlines the various features available for working with articles. Click on a    topic to 
view more information about that procedure.

Viewing Articles 
Creating Articles 
Editing Articles 
Linking Text to an Article 
Accessing Linked Articles 
Saving Articles 
Printing Articles 
Deleting Articles 
Associating Articles with Maps 
Associating Articles with Map Items 

Articles Associated to Maps
Among the 1,300 articles in American History Explorer, there are some related to the maps in a general
way. These associated articles can be divided into three categories:

Overview--General information about the map

People--Biographical sketches of people related to the map

Document--Historical documents related to the map

For more information, see:
Viewing Articles    
What's On a Map? 
Icon Bars    



 Working with Maps

American History Explorer comes with 93 maps, all with related articles and notations to explain their 
historic significance.

In addition, if you choose the Read/Write installation option, you can create your own maps using 
"background" maps provided with the program. Background maps are outlines of a particular geographic 
region. They are available with and without topographic features.

A variety of options are available to help you review and create maps easily. For example, you can display
a legend, measure the distance between one or more points on a map, zoom in and out of a map, search 
for map items, and even draw your own items on maps. The available features are listed in the topic list 
below. Click on any topic for more information.

Opening a Map 
Map Windows 
What is on a Map? 
Scrolling Through Maps
Map Legends 
Measuring Distance on a Map 
Zooming In and Out on a Map 
Zooming a Selected Map Area 
Performing a Search 
Viewing Articles 
Working with Map Items 
Changing the Map Background 
Creating a Map 
Using the Toolbox 
Saving a Map 
Copying Maps 
Deleting Maps 
Merging Maps 
Printing Maps 
Closing a Map 



 Working with Pictures

American History Explorer comes with a collection of more than a thousand images that you can view. 
In addition to the standard two-dimensional pictures, the program includes both modern and antique 
stereo images that simulate a three-dimensional picture.

The pictures can be accessed from several different locations. 

For more information, click on any of the following topics:

Accessing Pictures 
Viewing 3D Images 



 Playing Movies and Slide Shows

Thanks to the multimedia features of American History Explorer, you can now listen to, as well as read 
about, the highlights of American history. Choose from six exciting videos and 110 educational slide 
shows to bring the past into perspective.

For tips on using these features, select a topic from the following list:

Accessing Videos 
Accessing Slide Shows 
Stopping Videos 
Operating Slide Show Controls 



 Playing Songs and Games

Once you've studied the facts included in American History Explorer, you can move on to the fun: Enjoy
tunes from yesteryear or challenge yourself with 5Ws, an educational game.

Tips on using these features are included in the following topics:

Opening the Song Book    
About the Musicians 
Rules for Playing 5Ws 



 Time Trek Time Lines

The time lines included in American History Explorer are more than illustrations. Each one can be used 
as a chronological "port of entry" into the program's database.

Articles accessible through each marked year on the time line serve as a beginning point for study. The 
articles, maps, presidential profiles, and documents that branch off the main line help put people and 
events into perspective. The videos that accompany each time line bring a segment of history to life.

For tips on using the time lines, see the following topics:

Accessing Time Line Year Articles 
Opening a Time Line 
Scrolling Forward and Backward in a Time Line 
Accessing Items on a Time Line 
Exiting a Time Line 



 Printing

For assistance in printing out the maps or articles included with American History Explorer, select one 
of the topics below:

Print Setup 
Print Setup Dialog Box 
Printing Articles 
Printing Maps 
For more information see:
Fonts 



 Optional Settings

There are several options you can set in American History Explorer to operate the program according 
to your personal preferences. Many of these options can be set in the Settings dialog box that is 
accessed from the Opening Screen. Other optional settings are available from the Options menu of Map 
windows and the Fonts menu of Article windows .

For instructions on your choices, select from the following list of topics:

Settings Dialog Box 
Displaying Legends 
Zooming 
Printing 
Fonts 



 Features of the Opening Screen

The Opening Screen of American History Explorer offers you eleven choices for exploring America's 
past. Passing your pointer cursor over any of the icons changes the cursor to a hand cursor, indicating 
that you're on a "Hot Spot." 

Clicking on a Hot Spot opens a screen where you can select an item related to that feature. For example, 
clicking on the Slide Shows icon opens a Select Slide Show dialog box where you can choose which slide
show you want to view.

Following is a list of the icons and their associated features. Click on any icon name to access a related 
topic.

Source Book To research the nearly 1,400 articles

Map Studio To access 93 maps

Hall of Presidents To learn about the lives of early U.S. 
presidents

Slide Shows To select and view from 110 multimedia 
slide shows 

Movie Theater To select and view any of six original videos

Finder To search for any title, word, or partial word 
in the entire database

Time Trek To access a chronological view (time line) of
history

Picture Album To select from more than 1,000 pictures

3D Gallery To view modern and antique 3D images

Song Book To listen to period music

5Ws Game To play an educational game

For more information, see:
Program Tour 
Settings Dialog Box 



 Screen Elements

Depending on the options and features that you are using, various items may appear on the American 
History Explorer screen. Among the more involved screens are a dialog box (to select items), a Map 
window (to work with maps), and an Article window (to work with articles). 

For more information on these features, click on the appropriate topic below:

Using Dialog Boxes    
Map Windows 
Article Windows 

Additional information is available through the topics listed below. Click on any topic for more information.

Menu Bar 
Icon Bar 
Map Window 
Legends 
Articles 
Scroll Bars 
Status Bar 
Toolbox 
Desktop Window 
Minimize Button 
Maximize Button 



 Finding Help

American History Explorer for Windows is a user-friendly program that includes extensive online Help. 
You can access the online Help by pressing the F1 key on your keyboard from any location in the 
program. 

You can also find information by using the Help menu or Help icon which are available from either a Map 
window or an Article window.

When you access Help, you will be taken to a general topic list from which you can select the topic you 
need.

If you have a problem with operating the program, please consult your Online Guide and Online Help to 
review all the available information. If you're still unable to resolve your problem, consult the When You 
Need Help section within the Online Guide BEFORE contacting Parsons Technology. The Product 
Support option on the Help menu contains troubleshooting information you should review and follow 
whenever you encounter a problem operating the program. 

For more information see:
Help menu 



 Closing Screens

There are several ways you can close a screen, depending upon your installation choice (Read Only or 
Read/Write) and what program feature you are using. Available methods are described below.

Many program screens display a "curl" at the top or bottom of the right side of the screen. 
Clicking on this curl usually takes you back to the previous screen. From the Opening Screen, clicking the
curl exits the program.

Click the Close Map icon or the Close Article icon (if you're in a Map window or Article window). 
These icons are always available from the associated window. 

Select Close from the Map menu or the Article menu (if you're in a Map window or Article 
window). These menu options are available from the associated window only when you install the 
Read/Write version of the program.

Double-click on the Control-menu box in the top left corner of the open window (or click the 
Control-menu box once and select Close from the drop-down menu). 

For additional information, see:
Icon Bar 
Menu Bar 



 Exiting the Program

When you finish using American History Explorer, exit the program by closing all open windows to 
return to the Opening Screen. Then click the Exit curl at the bottom right corner of the screen.

Do NOT press the Ctrl+Alt+Del keys to exit the program. Doing so may cause you to lose your data. It 
would also cause any other applications you may be running under Windows to close. 

Also, make sure you exit American History Explorer and Windows before turning off your computer.

The method above produces a Verify dialog. On this dialog, you can select OK to exit the program or 
Cancel to return to the program.

For more information see:
Features of the Opening Screen 



 Program Copyrights

Articles labeled [GAHFF] are excerpts from:

The Great American History Fact-Finder, Copyright 1993 by Ted Yanak and Pam Cornelison. Published 
by Houghton Mifflin Company. All rights reserved.

Articles labeled [EHP] are excerpts from:

Encyclopedia of Historic Places, Facts on File, Copyright 1984, Courtlandt Canby. All rights reserved.

Articles labeled [BJUP] are excerpts from:

United States History for Christian Schools, Copyright 1991 Bob Jones University Press. All rights 
reserved.

Articles labeled [ENAIT] are excerpts from:

The Encyclopedia of North American Indian Tribes, Copyright 1986 Bison Books. All rights reserved.

Articles labeled [PT] are Copyright 1993, Parsons Technology, Inc.

Song Book songs by Bobby Horton are Copyright 1987, 1988 Bobby Horton.

Song Book songs by Linda Russell are Copyright 1984, 1991, Prairie Smoke Records.

Portions Copyright (C) 1984-1995 FairCom Corporation. All Rights Reserved.

All maps are Copyright 1993-1995, Parsons Technology, Inc.



 Using Copyrighted Material

One purpose of American History Explorer for Windows is to provide an easy way for you to create 
maps for use in your own personal studies, lessons, and presentations. The maps included with the 
program are copyrighted by Parsons Technology, and portions of the text are copyrighted by various 
publishers, but certain uses are allowed.

Federal copyright laws allow for "fair use" of copyrighted materials without permission under certain 
circumstances. The law allows the reproduction, distribution, and adaptation of copyrighted material if the 
use is "for purposes such as criticism, comment, news reporting, teaching (including multiple copies for 
classroom use), scholarship, or research."

To judge if your use falls under these guidelines, you should take into consideration ALL of the following:

1. Is the use commercial or non-profit educational? In general, commercial use is not covered under
"fair use."

2. Is the material relevant to the context in which it is used? That is, you can't justify copying the 
maps or other materials in the program by handing them out to a classroom full of people if the 
people aren't even studying U.S. history or geography.

3. How much of the material are you reproducing? In general, reproducing a small number of maps 
is allowed under "fair use," but reproducing all (or most) of the maps may not be.

4. What is the effect on the potential value of American History Explorer by your usage? If your 
usage may cut into sales of the program, it's likely your usage is not "fair." For example, if you are
going to reproduce our maps or large portions of text from copyrighted source materials to create 
your own textbook, you should consider asking permission first.

One rule to apply is to put yourself in our place. How would you react if someone used material you 
created in the way that you are contemplating using ours?

If you think your usage may not fall under "fair use," contact Parsons Technology at 1-319-395-9626. We'll
probably be able to handle your request by phone. But, if your situation is complicated, we may ask you to
write or send us a copy of your proposed usage of our material. We want you to use the maps included 
with the program; we have very few situations where we've absolutely refused. However, we may ask you
to give us credit in your work.

This information is not intended to be legal advice, nor to grant rights beyond those allowed under U.S. 
and international copyright laws. You should contact Parsons Technology and/or competent legal counsel 
if you have questions about the issues covered herein.

(Some of the material above is adapted from Every Writer's Guide to Copyright & Publishing Law by Ellen
M. Kozak, Copyright (c) 1990, Ellen M. Kozak.)
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 Map Menu

The basic functions you'll need as you're working with maps in American History Explorer can be found 
on the Map menu of a Map window. Options on this menu allow you to open, close, and save maps. You 
can also create new maps and delete them, set up your printing functions and print any maps. (To modify 
the items on a map, you'll use the Edit menu.)

For detailed information about the features available from this menu, click Working with Maps.

For more information see:
Print Setup 
Print Setup Dialog Box 
Printing 
Menu Bar 
Icon Bar 
Summary of Menus 
Edit Menu 
Articles Menu 
Search Menu 
Options Menu 
Help Menu 



 Edit Menu for Maps

Many of the functions you'll need as you're working with the items on maps in American History 
Explorer can be found on the Edit menu. Options on this menu allow you to create and manipulate map 
items, copy map items or portions of a map, edit the map legend, change the background for the map, 
merge two maps, and access the Toolbox to add graphics to a map. For detailed information about the 
features available from this menu, click Working with Map Items.

For more information see:
Swapping Backgrounds 
Merging Maps 
Toolbox 
Map Legends 
Summary of Menus 
Map Menu 
Articles Menu 
Search Menu 
Options Menu 
Help Menu 



 Articles Menu for Maps

The options on the Articles menu in a Map window allow you to instantly view any of the articles generally 
associated with a map. You can also choose different or original articles to associate with a map. 

With a Map window open, select the Articles menu option that best describes the type of information you'd
like to view about that map. Descriptions of your three choices are listed below.

Overview--General information about the map

People--Biographical sketches of people related to the map

Document--Historical documents related to the map 
For instructions on using the fourth option on the Articles menu, click Associating Articles with Maps.

For more information see:
Working with Articles 
Working with Maps 
Summary of Menus 
Map Menu 
Edit Menu 
Search Menu 
Options Menu 
Help Menu 



 Search Menu

The Search menu is available from any Map window (if you used the Read/Write installation option). It 
allows you to search for map items in the American History Explorer program. You can then view the 
item on a map or add it to a map.

Selecting Find/Select Items from the Search menu opens the Place/Names dialog where you can:

View a list of items on the current map.

View a list of items NOT on the current map, but exist on other maps. 

Add items to the current map.

Find and select items already on the current map.

View a list of maps containing a selected map item. 

Delete items from the program (if you used the Read/Write installation option). 

Various category check boxes are available so you can limit the types of information displayed on the 
dialog. For example, you can display cities only. Click on Limiting Categories for more information on this 
feature.

Click on Place/Names Dialog Box and Map Item List for more information on using this dialog.

For more information see:
Performing a Search 
Working with Map Items 
Deleting Map Items 
Working with Maps 
Summary of Menus 
Map Menu 
Edit Menu 
Articles Menu    
Options Menu 
Help Menu 



 Options Menu

The Options menu is available from any Map window (if you used the Read/Write installation option). You 
can use the options to modify maps to suit your needs. 

For more information on the options available from this menu, click the appropriate topic below.

Display Legend

Zoom
For more information see:
Working with Maps 
Summary of Menus 
Map Menu 
Edit Menu 
Articles Menu    
Search Menu 
Help Menu 



 Help Menu

The Help menu is available from any Map window or Article window (if you used the Read/Write 
installation option). It allows you to access information about operating the program and contacting 
Parsons Technology. The following explains each of the options available from the Help menu:

Online Help--contains a list of topics you can select to obtain additional information about how to use
the program and how to contact Parsons Technology for product support. From most topics, you 
can access additional or related topics as well.

About American History Explorer--lists the program version, copyright information, Settings 
options, and the team who worked to bring you American History Explorer.

For more information on finding help, click Finding Help.

For more information see:
Summary of Menus 
Map Menu 
Edit Menu for Maps 
Articles Menu    
Options Menu 
Search Menu 
Article Menu 
Edit Menu for Articles 
Links Menu 
Font Menu 



 Article Menu for Articles
With an Article window open, you have access to an Article menu (if you used the Read/Write installation 
option). This menu allows you to create new articles and delete them; open, save, and close the open 
article; copy articles to the Windows Clipboard, modify print settings; and print an article.

For details on any of these functions, click on a topic from the following list:

Creating Articles 
Opening Articles 
Saving Articles 
Copying Articles 
Deleting Articles 
Print Setup 
Print Setup Dialog Box 
Printing Articles 
Closing Articles 
For more information see:
Summary of Menus 
Edit Menu 
Links Menu 
Font Menu 
Help Menu 



 Edit Menu for Articles

The Edit menu that appears when you have an Article window open provides options you'll use when 
creating and editing articles. (Like all menus, it is only available if you choose the Read/Write installation 
option.)

For example, you can use features from the Edit menu to copy information from one article and paste it 
into another article. You can also use these features to move information from the American History 
Explorer database to a word processing application such as Word for Windows. For more information, 
click Moving Text to Word Processors

The following paragraphs explain each of the options available from this menu. Note that some of the 
options from this menu are available only if you have selected something in the active window. Others 
become available only when Edit Mode is selected from the Edit menu.

Undo--Reverses the last editing operation you performed. For example, if you moved a section of
text and want to replace it where it was originally, you can use the Undo option. Likewise, if you 
change text in an article, you can choose Undo to replace it with the original text. This option is 
available only when Edit Mode is checked.

Cut--Removes the selected text and places it on the Windows Clipboard. This option is available 
when you have text selected in an article and Edit Mode is checked.

Copy--Places a copy of the selected text from an article on the Windows Clipboard. 

Paste--Inserts text from the Clipboard at the current cursor position. This option is only available if
you have placed text on the Clipboard and Edit Mode is checked.

Find--Searches within the current article for the word or partial word that you enter. 

Repeat Find--Repeats the search within the current article for a word or partial word that you 
enter. 

Select All--Highlights all the text in the current window. 

Edit Mode--Allows you to make modifications to the open article. For example, you cannot cut 
text from, or paste text into, an article until you've placed the article in the edit mode. For details 
on this menu option, click Editing Articles. 

Use Cut and Copy to move text from an article to the Clipboard. Then move the cursor to another section 
of that article, to a different article or to a word processor and select Paste to insert the text from the 
Clipboard into the new location.

For more information see:
Summary of Menus 
Article Menu 
Links Menu 
Font Menu 
Help Menu 



 Links Menu

With an Article window open, the menu bar offers a Links menu which you can use to link or unlink other 
articles into the open article.

The options available from the Links menu are listed below with a description of their functions. 

Back--Open the previous article when viewing a series of linked articles.

Forward--Open the next article when viewing a series of previously viewed linked articles.

(In order to access any of the following features, you must first place the article in the edit mode.)

Link--Establish a "link" or jump between selected text in the open article and another article.

Unlink--Remove the "link" between selected text in the open article and another article.

For more information see:
Linking Articles 
Summary of Menus 
Article Menu 
Edit Menu 
Font Menu 
Help Menu 



 Font Menu

With an Article window open, the menu bar displays a Font menu which you can use to modify the text in 
articles. 

The options available from the Font menu are listed below with a description of their functions.

Font--Open the Font dialog where you can set the font, size, and style of type used to display the 
text in all articles. A sample of your selections is displayed at the bottom of the dialog box.

Bold--Bolds the selected text (when the article is in the Edit mode).

Italic--Italicizes the selected text (when the article is in the Edit mode).

Underline--Underlines the selected text (when the article is in the Edit mode).

For more information see:
Defining Font Characteristics    
Summary of Menus 
Article Menu 
Edit Menu 
Links Menu 
Help Menu 



 Icon Bar

When you open either an Article window or a Map window, the top of the window displays a row of 
buttons called an icon bar. If you installed the Read/Write version of the program, a list of menus called 
the menu bar. appears above the icon bar. (Click on Installation Options for more information.)

You can click on the icon buttons, instead of selecting menu options, to access frequently used American
History Explorer features. For example, if you have a Map window open, you can open the Select Map 
dialog box by clicking the left button on the icon bar rather than choosing Open from the Map menu.

For illustrations of each icon bar and information on the buttons available, click on the appropriate topic 
below.

Map Window Icon Bar 
Article Window Icon Bar 
For more information see:
Screen Elements 
Menu Bar 
Map Item list 
Map window 
Legend 
Articles 
Scroll Bars 
Status Bar 
Toolbox 
Minimize Button 
Maximize Button 



 Selecting Items and Using Buttons

Both the keyboard and mouse movements used in American History Explorer are typical of those found
in many software programs. You'll learn keystrokes for specific operations when actually using those 
features.

If you select the Read/Write installation option, you'll have access to menu bars in the Map windows and 
Article windows. (Some program functions have shortcut keys listed beside the corresponding menu 
option on the menu.)

To select an item, do one of the following:

Position the mouse pointer on the option and click.

Use the arrow keys to move the highlight to the item of your choice and press the Enter key or 
click OK. 

Click the mouse at the beginning of the item and hold the mouse button down while you drag the 
cursor over the item you wish to select.
To select a menu option:

Press Alt plus an option's underlined "pick letter." 

Press ONLY the option's underlined pick letter. This applies to menu bar options when the menu 
bar is active or to submenu options when the submenu is pulled down.
You'll use buttons to choose other program features. For example, buttons can perform actions, complete 
actions, and open windows to additional program features. They look like buttons on any electronic 
device. Rather than pressing the button, however, you click on it with your mouse or press the Alt key 
plus the button's underlined pick letter.

For more information see:
Selecting Map Items 
Selecting Graphics 
Arranging Graphics 
Smart Picker    
Selecting Parts of a Map    



 Entering Data

Many American History Explorer dialog boxes display blank spaces, called fields, ready for you to enter
information. You'll enter the information much like you would do using any word processor. 

When you first access a dialog box, a highlight bar usually appears in the first field. This highlight 
indicates your current location on the screen. To move the highlight from field to field, use the Tab key or 
your mouse.

Fields are designed to accept the keyboard characters that you enter. As you start to type characters, a 
blinking cursor indicates your location within the field. Characters include letters, numbers, punctuation 
marks, spaces, and other keyboard symbols. Some fields accept any characters, but other fields accept 
only certain ones.

For more information see:
Data Entry Keys
Deleting Data 
Entering New Field Information 
Marking Fields 
Smart Picker 
Using the Windows Clipboard Options 
Keyboard Commands 
Mouse Operations 



 Using Dialog Boxes

Throughout the American History Explorer program, information appears on the screen in dialog boxes.
(See the sample below.)

Different types of dialog boxes ask for different responses. Some require you to enter information; others 
offer buttons you can choose to access other program features. In certain cases, you must respond to a 
dialog box before you can proceed with program operations.

Many of the American History Explorer dialog boxes that you will encounter are listed here. To learn 
more about a particular one, click on it.

Edit Map Item Dialog Box 
Map Legend Dialog Box 
Merge Maps Dialog Box 
Place/Names Dialog Box 
Print Setup Dialog Box (for maps) 
Print Dialog Box (for maps) 
Save As Dialog Box (for articles) 
Save As Dialog Box (for maps) 
Select Article Dialog Box 
Select Attributes to Change Dialog Box 
Select Background Dialog Box 
Link Article Dialog Box 
Select Map Dialog Box 
Swap Backgrounds Dialog Box 
Zoom Map Dialog Box 
Search Dialog Box 
Select Picture Dialog Box 



 Searching for Map Items

Using a Map window's Search menu, you can look for cities, states, regions, events, famous people, 
geographical features, text, and other miscellaneous items on a map. Any map item included with the 
American History Explorer program (and those you add yourself) can be the object of your search.

To search for a map item in American History Explorer,
1. Open the map you want to search (or any map if you don't know where the item is located).

2. Select Find/Select Items from the Search menu (or click the Search icon on the icon bar). The 
Place/Names dialog box opens.

3. Click the Items on Current Map option (if the item you're searching for is on the open map) .

4. Highlight any item and click the Find button. The program will automatically pinpoint the location 
of the item on the open map by drawing a box around it.

You can also access a list of items NOT on the current map. Use this list to add a selected item to
the current map or click the Map Item List to locate a map that already displays the selected item.

You can obtain additional details about maps and map items by selecting one of the topics below.

Place/Names Dialog 
What is on a Map? 
Working with Maps 
Working with Map Items 
For more information see:
Finder 
Viewing Articles 
Opening a Map 



 Viewing Articles

There are several ways you can open an article: from the Source Book icon on the Opening Screen, from 
an Article window, and from a Map window. Instructions for each method are listed below. 

Accessing Articles from the Source Book
To view an article from the Source Book, follow these steps:

1. Go to the Opening Screen and click on the Source Book icon.

2. In the Select Article dialog box that appears, select the article you wish to view.

This list contains all articles included with the program and any you've created. You can move to 
an item quickly by typing its first few letters in the box above the list. To scroll through the list, use 
the scroll bars or press the down arrow on your keyboard.

3. Click OK (or press Enter). The selected article opens on screen in a window.

Accessing Primary Documents
"Primary Documents" are articles that contain the full text of selected historic American documents. These
include the Declaration of Independence, the Constitution of the United States, the Articles of 
Confederation, Lincoln's Gettysburg Address, the inaugural addresses of the first 21 U.S. Presidents, the 
Privileges and Prerogatives Granted to Christopher Columbus, and more.

These articles are included alphabetically in the Select Article dialog. You can also select "Primary 
Documents" from this dialog to open an article that lists all the Primary Documents and allows you to 
access them. In addition, many of the Primary Documents are associated with various maps and can be 
accessed from those maps by clicking the Document Article icon on the icon bar.

Text from the documents for any article can be copied to the Windows Clipboard for use with your word 
processor.

Accessing Articles from an Article Window
If you're in an Article window, follow these steps to view another article:

1. Choose Open from the Article menu or click on the Open Article icon on the icon bar to open the 
Select Article dialog box.

2. Follow steps 2 and 3 in the procedure above.

NOTE:    It is not necessary to close the current article before opening a 
different article; the new article will replace the current article.

Accessing Articles from a Map Window
From a Map window, you can view articles associated with the open map by following these steps:

1. Select Overview, People, or Document from the Articles menu.

If only one article is associated with the map, that article will appear immediately in an Article 
window. 

If more than one article is associated with the map, you will be presented with a list of articles 
from which to select.

2. From the list of articles, select the article you wish to view by double-clicking on the linked 
(colored) text.



Accessing Map Item Articles
Most of the items on a map (the cities, battles, etc.) are associated with an article. To access the article 
associated with any map item, double-click on the map item name or icon.

Accessing Articles from a Time Line
With a time line open, you can quickly access any of the Year articles that mark the dates on the time line 
or any other article that branches off the main time line. 

To view a Year article,

1. Move your cursor over the year on the time line.

2. When the cursor turns to a hand, click on the date. The Year article for that date opens in an 
Article window. The Year article will include a list of articles related to the selected year.

3. From the list of articles, select the article you wish to view by double-clicking on the linked 
(colored) text.

To view other articles on the time line, click on the appropriate article icon or document icon.

Accessing Linked Articles
Once you have an article open, you can access information about any word that appears in another color 
within the article by double clicking on it. This will replace the contents of the current Article window with 
the article for the selected item. For more information on this procedure, click Accessing Linked Articles.

Closing Articles
To close any article, use any of the following methods:

Choose Close from the Article menu.

Click the Close Article icon on the icon bar.

Double-click on the close-menu box in the upper left corner of the Article window.

For more information see:
Editing Articles 
Working with Articles 
Printing Articles 
Time Line Year Articles 
Time Lines 



 Creating Articles

You can create your own articles and then associate them to a map or to a map item. (You must use the 
Read/Write installation option to perform these operations.)

To create an article,

1. Open any Article window. (Click on Viewing Articles, if you need instructions.)

2. Choose New from the Article menu to open an untitled Article window.

The Article window in Edit mode serves as a simple word processor. Type the information you 
want to include in your article. For a map overview article, you'll want to provide general 
background information for the map to which the article will be associated. For a text article to be 
associated with a map item, you'll want to include more detailed information about the specific 
person, place or event.

3. When you're done, choose Save from the Articles menu.

4. In the Save As dialog that appears, enter a name for your article--up to 60 characters--and click 
OK (or press Enter).
Your new article is added to the program and will appear in the list of existing articles displayed in 
the Select Article dialog box that opens when you choose to open an article. You can now 
associate the article to a map or to a map item. Click Associating Articles with Maps and 
Associating Articles with Map Items for details on these procedures.

For more information see:
Defining Font Characteristics 
Linking Text to an Article 
Saving Articles 
Printing Articles 
Working with Articles 



 Editing Articles

You can edit existing articles or those you've created yourself, then save the changes or save the article 
with a new name (to make a copy).

To edit an article:

1. Open the desired article.

2. Choose Edit Mode from the Edit menu. This places the article into the Edit mode. A check mark 
appears next to the Edit Mode menu option when you enable the Edit mode for the current article.
(Later, when you finish, you can disable the Edit mode by reselecting the Edit Mode option.)

3. Make the desired changes in the article's text as you would edit any document on a word 
processor. For details on using bold, italics, and underlines to emphasize text, click Defining Font 
Characteristics.

4. Choose Save or Save As from the Articles menu to save your changes:

Save--overwrites the previous version of the article. 

Save As--opens a Save As dialog where you can enter a new name for the edited article. This 
allows you to preserve the previous version of the text as well as the edited one. (In other words, 
you're creating a copy of the original). To save, click OK.

If you try to leave the Edit mode or close the article without saving the article first, the program 
presents a dialog, asking if you want to save the changes.

For more information see:
Edit menu 
Linking Text to an Article 
Associating Articles with Maps 
Associating Articles with Map Items 
Saving Articles 
Printing Articles 
Working with Articles 



 Linking Text to an Article

Links in American History Explorer are ties between one article and another one that may contain 
related information. Links are marked by text of a different color. While many links exist in the original 
articles when you receive the program, you may want to add others.

To create a link within an article:

1. Open the appropriate Article window.

2. Choose Edit Mode from the Edit menu to activate the Edit mode. If a check mark already appears
next to this option on the menu, skip this step.

3. Highlight the word or words within the article that are to be linked.

4. Choose Link from the Links menu to open the Link Article dialog box.

The dialog lists all existing articles. If American History Explorer locates an exact match for 
your selected text, that item is highlighted in the Link Article list. The program will attempt to offer 
a selection even if no match is found. In either instance, you can accept the offered item or select 
an alternative.

5. Highlight the desired item, then click OK to establish the link. Within the article, the selected text 
now appears in the color of other linked items. 

6. Choose Save or Save As to save the new link. 

(Click Saving Articles for details on these options.)

7. Deactivate the Edit mode by reselecting the Edit Mode option on the Edit menu. 

For more information see:
Editing Articles 
Associating Articles with Maps 
Associating Articles with Map Items 
Changing Link Color 



 Accessing Linked Articles

Many articles contain "links"--one or more words displayed in a different color to distinguish them from 
normal text. These words are ties to related articles. Double-click on one of these words to jump to the 
related article. The related article replaces the original one in the current window.

The related article may have additional links, so you can easily lose track of the original article after 
viewing other linked articles. To move back and forth between the articles you've viewed, choose Back or 
Forward from the Links menu (or click on the Previous Linked Article or Next Linked Article icons on the 
icon bar).

For more information see:
Changing Link Color
Viewing Articles 
Working with Articles 



 Saving Articles

If you are creating a new article (or modifying an existing one) and wish to save your changes, select 
Save or Save As from the Article menu. 

The Save option allows you to save a new article for the first time and give it a name. This option also 
allows you to save existing articles under their original name. 

The Save As option allows you to make a copy of an article and enter a name for the new article.

To save an article currently active on screen:

1. Select Save or Save As from the Article menu (whichever is appropriate).

2. If you're saving an article you created for the first time (or you chose the Save As option), a Save 
As dialog appears where you can enter a name of up to 60 characters for your article. 

If you selected the Save option and have saved the article before, the Save As dialog doesn't 
appear; your changes are saved automatically, overwriting the previous version of the article.

If you selected the Save option on an article that came with the program, a dialog box notifies you
that you may be changing an original article and asks if you want to continue. 

If you try to leave the edit mode or close the article without first saving it, the program presents a dialog 
box, asking if you want to save the changes.

For more information see:
Creating Articles 
Editing Articles 
Working with Articles 



 Printing Articles

You can print any articles included with the program and any you've created yourself. 

To print an article:

1. Open the article (or activate the window in which it is already open by clicking anywhere in that 
window).

2. Select Print from the Article menu or click on the Print Article icon on the icon bar.

The article in the currently active window is printed. The article is printed with one inch margins. The 
program uses the font characteristics currently defined in the Font dialog box. To review or modify those 
settings, select Font from the Font menu.

For more information see:
Printer Setup 
Working with Articles 



 Deleting Articles

American History Explorer allows you to delete any articles that you have added to the program. You 
can NOT delete the articles that are provided with the program.

If you want to delete an article you added to the program, 

1. Open the article that you wish to delete.

2. Select Edit Mode from the Edit menu.

3. Select Delete from the Article menu. 

A verify dialog appears where you can click OK to permanently delete the current article or click 
Cancel to cancel the operation. 

For more information see:
Working with Articles 



 Associating Articles with Maps

All maps included with the program have an associated text article that provides more details about the 
information depicted on the map. 

Likewise, you can create your own articles to supplement the maps you create, or those included with the 
program. To do this, you will create an article (click Creating Articles for details), then associate that article
with the map.

To associate an existing article to a map:

1. Open the map that you want to associate with your article.

2. Select Associate Articles to Map from the Articles menu of the Map window. A drop-down menu 
displays three choices -- Overview, People, and Document.

3. Click on the appropriate category and select the desired article from the list of existing articles.

You can move to an item in the list quickly by typing its first few letters in the appropriate field 
above. Use the scroll bars or the down arrow on your keyboard to scroll through the list.

4. When the desired item is highlighted, click OK (or press Enter) to establish the association. 

TIP: To associate more than one People or Document article to a map, 
simply create one "container" article in which you list all the people or 
documents you want related to a map, then use the linking feature to 
connect the articles as needed. (For more information on linking, click 
the appropriate topic in the list below.)

For more information see:
Opening a Map 
Viewing Articles 
Associating Articles with Map Items 
Linking Text Within an Article 
Unlinking Text Within an Article 
Working with Articles 



 Associating Articles with Map Items

You may want to associate existing articles with map items. For example, you can associate an article 
you created yourself with an item you added to a map. This allows you to access information about that 
event at the click of a mouse.

To associate an article with a map item:

1. Open the appropriate map and select the map item to which the article will be associated. (Just 
click on the map item.)

2. Select Edit Items from the Edit menu of the Map window (or click on the Edit Map Item icon on the
icon bar).

3. In the Edit Map Item dialog that appears, click on the down arrow beside the Text Article input 
field to view a list of available articles.

4. Highlight the desired article, then click OK to establish the association. The Map window returns.

To check the association to be sure it's enabled, double click on the map item. The appropriate text article
should open in an Article window on top of the map.

For more information see:
Associating Articles with Maps 
Linking Text to an Article 
Unlinking Text Within an Article 
Working with Articles 



 Opening a Map

To open any of the maps in the program, 

1. Click on the Map Studio icon in the Opening Screen. (Once you have a map open, you can open 
a different map by clicking the Open Map icon on the icon bar or selecting Open from the Map 
menu.) This opens the Select Map dialog box.

Initially, the Select Map dialog will list only those maps included with the American History 
Explorer program. Later, if you've added maps that you create yourself, the names of those 
maps will appear in the dialog box, too. 

2. Locate the map you wish to open. 

Initially, the maps are listed in alphabetical order. However, most maps included with the program 
are associated with a time period, indicating the era of the map. So, you can choose to sort them 
by time period order if you like (which will display the appropriate time period followed by the map
name). To sort by time period, click on Time Period in the Sort Order preference near the bottom 
of the dialog box.

(Since more maps are available than can be presented in the dialog window at one time, you may
need to use the scroll bar to find the one you want.) 

3. When you've located the map you want, click on it with your mouse to highlight it, then click OK to
open it (or, you can simply double-click on the map name to open it). 

To select a map using the keyboard, use the arrow keys, PgUp, or PgDn to position the highlight 
on the name of the map you want to view and press Enter. The selected map opens on screen. 

For more information see:
What is on a Map? 
Scrolling Through Maps 
Working with Maps 
Working with Map Items 



 What is on a Map?

All maps included with the program contain a variety of information. The following is a list of the items that
could display on a map:

A background or geographical outline of the area that the map covers. The background includes 
the boundaries of map regions and may include topographical details associated with the map.

Map items, such as people, places, and events associated with the map. Map items can be 
names or symbols (for example, crossed swords are used to designate battle sites). Symbols are defined 
in the map legend (See next item.) Double-clicking on a map item will open an associated article.

A legend providing a key for the map item symbols, a distance scale, and an elevation scale. This
may appear on the map when you first open it. If not, click the Legend icon on the icon bar or choose 
Display Legend from the Options menu.

Some maps also contain graphics that illustrate historical events. For example, lines are often 
used to illustrate a journey (depicting the explorations of Ponce de Leon on the Exploration of the U.S. 
map, for instance).

NOTE:      Additional information may be associated with a map, but not 
displayed on the map, For example, there may be associated Overview,
People, and Document articles or associated slide shows. For 
information on these features, click on Map Window, Map Icon Bar, and 
Menu Summary

For more information see:
Scrolling Through Maps 
Inserting Graphics into a Map 
Working with Maps 
Working with Map Items 



 Scrolling Through Maps

Many maps are too large to display fully, even in a maximized window. Scroll bars at the bottom and right 
edges of the Map window provide access to areas hidden from view. 

You may find, however, that the scrolling procedure on a Map window may be somewhat slower than 
normal. This is because only a portion of the map loads into memory when you first open the map. (This 
is done to conserve memory.) As you scroll, the program is loading more of the map into memory in order 
to display the new areas of the map, resulting in a slight delay. 

Depending on the amount of memory you have available, you may notice that scrolling is faster when you
scroll back to areas of the map you've already viewed. This is because these areas of the map have 
already been loaded into memory and do not need reloading.

You can adjust the scrolling speed to a certain extent by modifying the Scroll Units setting. Click on 
Settings Dialog Box for more information.

For more information see:
What is on a Map? 



 Editing the Map Legend

American History Explorer has a map legend feature you can use to clarify the information contained on
a map. Every map has a legend, even a new map you are creating. 

To display the legend for a map, open the desired map and select Display Legend from the Options menu
or click on the Legend icon. The appropriate map legend appears on the map within the Map window.

Most maps included with the program already have a map legend with legend items for events depicted 
on the map. If you're creating a new map, only the distance scale and the elevation scale (if your map 
background is topographical) appear; you will need to enter your own legend items.

If you chose the Read/Write installation option, you can change the items on a map legend and modify 
the display options from the Map Legend dialog. To access this dialog box, select Edit Legend from the 
Edit menu of a Map window. This dialog also allows you to create legends for your own user-defined 
maps. 

For details on using this dialog, click Map Legend Dialog Box.

The check boxes at the top of the Map Legend dialog allow you to enable and disable the available 
display options for the current map's legend. The Print map name option allows you to print the name of 
the map on the legend when you print the map.

The eight boxes that appear in the Legend Items section of the dialog allow you to specify icons and text 
labels you want to appear on the legend and to specify how you want them to look. You can hide the icon 
if you don't want it displayed by checking the Hide the icon check box (in case you want only text on the 
legend, for example). Notice that when you enter information in a Legend Items box, an example of how 
the item will appear on the actual legend appears at the bottom of the Map Legend dialog.

Saving Maps with Legends/Closing the Legend
If you want the legend to display automatically each time you open a particular map, just save the map 
with the legend displayed. The next time you open the map, the legend appears automatically. Likewise, if
you don't want the legend to display when you open a particular map, close the legend and save the map.

To close the legend, double click on the Control-menu box icon in the upper left corner of the legend 
window, click on the Legend icon, or select Display Legend from the Options menu to remove the check 
mark from the Display Legend option. 

For details on saving maps, click Saving a Map.

For more information see:
Working with Maps 



 Measuring Distance on a Map

American History Explorer has a distance measurement feature you can use to calculate the distance 
between two or more points on a map. 

Measuring Distance Between Map Locations
To measure a distance,

1. Activate the arrow cursor by clicking on it on the icon bar.

2. Position the cursor at the desired starting point.

3. Click and hold the left mouse button as you drag the cursor to any other location on the map. Or, 
you can hold the Ctrl key down as you click on various map items to display the distance 
between all of the selected items.

The distance continuously updates and displays on the status bar. A line from your starting point to the 
current position of the mouse cursor helps you track your movements. When you release the mouse 
button, the line disappears and the distance from your starting point to the last location remains displayed 
on the status bar until you select another item.

Measuring Distance to a Hidden Location
You can also measure distances to map locations not initially displayed on the screen. Click the first 
location, hold down the left mouse button, and drag the cursor in the direction of the hidden location. 
When you reach the edge of the map, let the mouse cursor gently "bump" the edge of the Map window 
until the desired location is visible. Continue on until the cursor is positioned on the end location and 
release. 

Measuring Distance with the Place/Names Dialog
You can also measure the distance between two places in the Place/Names dialog. To do so:

1. Open the Place/Names dialog by clicking the Search icon (or choose Find/Select items from the 
Search menu).

2. Highlight two or more items on the dialog by clicking on the first item, then pressing the Ctrl 
button while clicking on other items. The cumulative distance will be displayed on the status bar of
the Map window.

For more information see:
What is on a Map? 
Scrolling Through Maps 
Working with Maps 
Working with Map Items 



 Zooming In and Out on a Map

American History Explorer allows you to zoom in on a smaller area of the map or to zoom out to view 
more, or all, of the map from a greater distance. Zooming out can reduce the need to scroll. Zoom works 
with all American History Explorer maps.

To zoom, either in or out, choose Zoom Map from the Options menu or click the Zoom button on the icon 
bar. The Zoom Map dialog opens on screen. The current zoom level is displayed near the right center of 
the box. You can adjust the zoom level by:

Typing a value directly into the Set Level field.

Using the Zoom In/Zoom Out scroll bar on the left side of the box.
You can set values from 0.25 (zoomed out to reveal the largest area of the map) to 1.5 (zoomed in to 
show the smallest area). When you're satisfied with the setting, click OK. Depending upon your computer 
system and the degree of change, the modification may take several moments to implement. 

NOTE:    If you zoom your map out to such a degree that any text on it 
would be impossible to read, the text may not display at all. Do not be 
concerned. The information has not been deleted and will reappear 
when you zoom back.)

Zooming a Selected Map Area
You can also zoom a selected area of a map to examine it in greater detail. For details on this procedure, 
click Zooming a Selected Map Area.

For more information see:
What is on a Map? 
Scrolling Through Maps 
Working with Maps 
Working with Map Items 



 Zooming a Selected Map Area

American History Explorer allows you to zoom in on a specific area of a map, rather than the whole 
map.

To zoom a selected area,

1. Select the area you want to zoom with the pointer cursor, using the RIGHT mouse button. (Click 
Selecting Parts of a Map for details.)

2. Click on the Zoom icon on the icon bar or select Zoom from the Options menu. The zoomed area 
appears within the active Map window.

The program will attempt to zoom the selected area so that it fills the current window. The program may 
adjust the zoom level to accommodate this (up to the maximum zoom level of 1.5). To restore the rest of 
the map, zoom back out by reducing the zoom level on the Zoom Map dialog (accessed by clicking the 
Zoom icon or selecting Zoom from the Options menu). 

For more information see:
Zooming In and Out on a Map 
Copying Maps to the Windows Clipboard 
Saving Maps 
Printing Maps 
Working with Maps 



 Working with Map Items

The 93 maps included with American History Explorer feature map items to supplement your 
understanding of the map. These map items, such as cities, famous battles, etc. can be located, moved, 
modified, added to, and deleted from maps. 

Click any of the topics below for more information on performing these functions.

Accessing Information about Map Items 
Adding Map Items 
Selecting Map Items 
Moving Map Items 
Editing Map Items 
Deleting Map Items 
Finding Map Items 
Associating Articles with Map Items 



 Changing the Map Background

If you want to change the background of your map (to use modern state boundaries instead of 
topography, for example), you can select the background you want from a list of predefined background 
maps (assuming you chose the Read/Write installation option).

To change the background for a map currently active on screen,

1. Select Swap Backgrounds from the Edit menu. The Swap Backgrounds dialog appears. Notice 
that the background currently being used is displayed at the top of the dialog. In the middle of the 
dialog, a list of the available background maps is displayed.

2. Click on the desired background map on the list or type the first few characters of the map's name
in the box above the list to locate a specific map.

3. Click OK (or press Enter) to replace the old background with the newly selected background. The
program rearranges the map items accordingly and the result appears on screen.

NOTE: If you swap in a completely different type of background (rather 
than just swapping in another version of the same background), you 
may not be able to see all of the map items and graphics if they extend
beyond the boundaries of the new map background. Items may appear 
larger or smaller than they did on the original map and may overlap, 
depending on whether or not the new map background covers more or 
less area than the original.

For more information see:
Background Maps 
Saving Maps 
Working with Maps 
Working with Map Items 



 Creating a Map

American History Explorer includes 93 maps for a variety of uses and applications. The maps included 
with the program come complete with text and notations. In addition background maps have also been 
provided. These are outlines of a particular geographical region. You can use these backgrounds as a 
base for creating your own maps. 

Backgrounds are available with and without topographical features.

One easy way to create a map is to open an existing map and modify it to suit your needs. But, you can 
also start from scratch. To do so,

1. Select New from the Map menu. The Select Background dialog box opens.

2. Choose the desired background from the dialog.

Whether you're modifying an existing map or starting from scratch, you can add map items, 
display and modify the map legend, and add graphics to create a map that fits your objectives 
precisely. Information about each of these functions (and more) is included in the following topics.

Background Maps 
Adding Map Items 
Selecting Map Items 
Moving Map Items 
Editing Map Items 
Deleting Map Items
Changing the Map Background 
Editing the Map Legend 
Inserting Graphics into a Map 
Opening a Map 
Saving Maps 
Working with Maps 
Working with Map Items 



 Saving a Map

After you've finished modifying or creating your map, you can save it to view it again later. 

To save a map currently active on-screen:

1. Select Save from the Map menu.

2. If you're saving a user-defined map for the first time, a Save As dialog appears where you can 
enter a name of up to 60 characters for your map. You can also enter a date to indicate the time 
period of the map if you like. This date is used for sorting maps chronologically in the Select Map 
dialog.

The program recognizes standard month abbreviations as well as most standard date 
abbreviating formats (for example, 7/4/1776; or July 4, 1776; or 7-4-1776); however, you must 
enter all four digits of the year (1776, not '76). Maps covering a range of dates are sorted 
chronologically.

If you're saving an original map included with the program, a warning dialog appears indicating that you 
are about to override original reference material. Click Yes to continue (which will replace the existing map
with the changed version) or click No to cancel the selection. Select Save As from the Map menu to save 
the changed map under a new name (leaving the existing map unchanged).

When you save a map, the program remembers the current scroll position so that next time you open the 
map, the map is positioned as it was when you last saved it. If you have the legend displayed when you 
save the map, it will automatically be displayed the next time you open the map.

For more information see:
Copying Maps 
Printing Maps 
Working with Maps 



 Copying Maps

If you want to create a copy of a map, use the following procedures:

1. Open the map you want to copy.

2. Select Save As from the Map menu. A Save As dialog appears where you can enter a new name 
(up to 60 characters) and date for the map. After you've entered a new name and date, click OK 
to make a copy of the map under the new name you entered.

You might want to use this feature if you intend to make changes to an original map and want to make 
sure your changes do not affect the original.

For more information see:
Copying Maps to the Windows Clipboard 
Saving a Map 
Merging Maps 
Printing Maps 
Working with Maps 



 Deleting Maps

American History Explorer allows you to delete any maps that you have added to the program. You can 
NOT delete the maps that are provided with the program.

If you want to delete a map that you've added to the program, follow these steps:

1. Open the map that you wish to delete.

2. Select Delete from the Map menu. 

3. A verify dialog appears where you can click Yes to permanently delete the current map or click No
to cancel the operation. 

For more information see:
Working with Maps 



 Merging Maps

If you want to combine two maps, you can use the Merge Maps feature on the Edit menu of a Map 
window. Simply open a map and then merge items from a selected map into the current map. 

For example, you can open the map Native American Culture Areas that shows the location of various 
tribes and merge it with the Arteries of the Nation, Pony Express map to see the location of various tribes 
in relation to the Pony Express route. To do this,

1. Open your first map (Native American Culture Areas, for our example). If you need assistance, 
click Opening Maps.

2. Select Merge Maps from the Edit menu. The Merge Maps dialog appears.

3. Select your second map (Arteries of the Nation, Pony Express, for our example).

4. Click OK (or press Enter). All of the map items from the second map appear on the first map. (In 
our example, the items from the Pony Express map appear on the Native American Culture Areas
map.)

NOTE: When merging, if not all of the selected map's items appear on 
the current map, it may be because they fall outside the boundaries of 
the map. (However, they are still part of the map and they will appear 
as items on the map on the Place/Names dialog.) Merged items may 
appear larger or smaller than they did on the original map and may 
overlap items on the current map.

For more information see:
Saving Maps 
Copying Maps 
Printing Maps 
Working with Maps 



 Printing Maps

You can print any maps you've created or any included with the program. If you have a color printer, you 
can even print out American History Explorer maps in full color. The following instructions outline how to
print a map.

1. Open the desired map.

2. Select Print from the Map menu or click on the Print Map icon.

3. On the Print dialog that appears, define the following:

Area to be printed (selected rectangle, current window, or entire map).

The top, bottom, left, and right margins.

Print style (gray scale, black and white, or color).

You can also specify whether or not you want the events depicted on the current map to be 
printed. To print any events shown on the current map, use the spacebar or your mouse to check 
the Print event markers check box at the bottom of the Print dialog. Leave this box unchecked if 
you do not want events printed on the map.

4. When done, click Print to print the map as indicated.

Printing the Map Name on the Legend
The map name will print on the map legend whenever you print legends on your maps if the Print map 
name check box in the Map Legend dialog is checked. To disable this feature, select Edit Legend from the
Edit menu and use the spacebar or your mouse to uncheck the Print map name check box at the top of 
the Map Legend dialog.

Scaling the Legend
When printing maps with legends, the program will attempt to scale the map legend based on the print 
options you've selected. If, however, the legend would be too small if scaled as specified (the print would 
be illegible, for example), a message will appear indicating the program cannot print the map. Likewise, if 
the legend would be too big if scaled as specified (the legend would take up most of the map, for 
example), a similar message will appear. In either case, the message will allow you to continue printing 
without the legend or to cancel the print operation.

For more information see:
Printer Setup 
Selecting Portions of a Map 
Working with Maps 



 Closing a Map

There are three ways to close a map currently active on screen:

Select Close from the Map menu.

Click on the Close Map icon on the icon bar.

Double-click on the control-menu box in the upper left corner of the Map window. 

For more information see:
Working with Maps 



 Accessing Information about Map Items

To access the article for a specific item on a map, double click on the item of interest. An Article window 
opens on top of the current Map window, displaying information relating to that item.

Some words in the article may appear in another color. These are "links" to other articles contained in the 
program. Links are ties between one article and another one that may contain related information. To 
review information for a particular word or phrase, double click on the colored text. The new article 
replaces the previous one within the Article window. 

Click Accessing Linked Articles for details on using associations.

To close an article, choose Close from the Article menu in the Article window or click on the Close Article 
icon on the icon bar. 

For more information see:
Working with Maps 
Working with Map Items 
Working with Articles 



 Adding Map Items

Whether you're modifying an existing map or creating your own, you may want to add cities regions, 
rivers, events, or other items to your map.

The easiest way to add map items is to select from among the list of existing map items included with the 
program. You can also create your own map items if you like. Click the appropriate topic below for more 
information on selecting items to add to a map and creating your own map items.

For more information see:
Selecting Items to Add to a Map 
Creating Your Own Map Items 
Creating a Map 
Working with Map Items 
Working with Maps 



 Selecting Map Items

You can select a group of map items on a map to edit them simultaneously. For example, if you want to 
change the color for all the cities on the map, you first need to select the cities. 

There are two ways you can select multiple items: 

On the map

Using the Place/Names dialog

Selecting Items on a Map
To select a group of map items on a map:

1. Open a map.

2. Activate the arrow cursor by clicking on the Arrow Cursor icon on the icon bar.

3. Press and hold the Ctrl key as you click on each map item you want to select with your mouse.

4. With the appropriate items selected, you are now ready to edit or delete them as needed. 

Click Editing Map Items or Deleting Map Items for details.

Selecting Items Using the Place/Names Dialog
To select a group of map items using the Place/Names dialog:

1. Open a map.

2. Choose Find/Select Items from the Search menu or click on the Search icon on the icon bar. The 
Place/Names dialog appears.

3. From the list of items on the map, highlight the map items you want to select.

To select items individually, press and hold the Ctrl key as you click on each item.

To select several items in a row, click on the first item, then press and hold the Shift key as you 
click on the last item; all the items in the specified block are selected. 

You can limit the types of map items displayed on the list by cities, regions, etc. to make selecting
items easier. Use the check boxes in the lower, right corner of the dialog.

4. With the appropriate items selected, you can edit or delete them as needed. 

Click Editing Map Items or Deleting Map Items for details.

For more information see:
Working with Map Items 
Working with Maps 



 Moving Map Items

When editing a map (or creating a new one), you may want to move map items to a different location or 
just make a few minor adjustments. For example, if you modify the zoom level for a map, the city names 
may have to be moved slightly to make them easier to read.

To move a map item within an open Map window:

1. Click on the Hand Cursor on the icon bar (or choose Move Items from the Edit menu to activate 
the hand cursor).

2. Position the hand cursor's extended index finger on the item you wish to move (a city name or 
icon, for example).

3. Click and hold the left mouse button to select the item. (Note that if the item selected has an icon,
both the name and the icon are selected.)

4. Drag the item to the desired location and release the mouse button. The program will reposition 
the item as indicated. For example, if you moved a city's icon, both the icon and the name are 
repositioned. If you moved the city's name, only the name is adjusted (the icon is unchanged).

NOTE: If you move an icon, a Message dialog appears asking you if you
want this change to affect all maps on which the item appears. Click Yes
to make a global change affecting all maps or click No to change the 
item on the current map only. To cancel the operation (and leave the 
icon where it was originally), click Cancel. If you select Yes, the item will
be modified on all maps, regardless of whether or not you save the 
current map.

For more information see:
Working with Map Items 
Working with Maps 



 Editing Map Items

When modifying a map, you may occasionally need to edit or delete map items. You can edit/delete items 
individually or select a group of items to edit or delete. For example, you can move a city's name or you 
can change the font color for all cities on a map. In order to modify the font color for all cities on a map, 
you must first select all the cities. You can do this by holding the Ctrl key as you click on each city or 
using the Place/Names dialog.

To edit one or more map items:

1. Select the item (or items) you wish to edit. 

To select one item, click on it with your mouse. For details on selecting multiple map items, click 
Selecting Map Items.

2. Click on the Edit Map Item icon on the icon bar (or select Edit Items from the Edit menu of the 
Map window). The Edit Map Item dialog appears. 

(Note that if you are editing several map items at once, nothing appears in the Name field on this 
dialog. Additionally, other fields may be blank if the items selected do not have the same display 
attributes.)

3. Make the appropriate modifications. For information about the fields contained on the dialog, click
Edit Map Item Dialog.

This Edit Map Item dialog functions the same as the Edit Map Item dialog you see when you are 
adding a new map item. However, an additional check box appears at the bottom of the dialog. 
The Change item(s) on all maps check box allows you to indicate whether or not the changes 
made should be global (thus, affecting all maps on which the selected item appears). Leave this 
check box blank to change the current map only. Use the spacebar or your mouse to check the 
box if you want to make a global change. 

4. When done, click OK to save your changes.

If you did not check the Change Item(s) on All Maps check box on the Edit Map Item dialog, you 
will return to the Map window immediately. If you made a cosmetic change affecting how the map 
looks, you will immediately be able to see your modification(s). If you changed the text article 
attached to the map item, you will need to access the text article by double clicking on the map 
item to see your change.

If you checked the Change Item(s) on All Maps check box, a Select Attributes to Change dialog 
appears. This dialog outlines the types of modifications you made (name, font, icon, text article, 
etc.) and gives you an opportunity to select the items you want changed. Each area you have 
changed is automatically selected by default; you can deselect the items you don't want changed.
When you've selected all appropriate items, click OK to update all maps and return to the Map 
window. 

If you are modifying an original map included with the program, a message dialog appears 
prompting you to verify your selection. Click YES to proceed or NO to cancel the global change 
(so only the current map is modified).

For more information see:
Selecting Multiple Map Items 
Moving Map Items 
Deleting Map Items 
Saving Maps 
Working with Map Items 
Working with Maps 





 Deleting Map Items

While creating or editing a map, you may want to delete one or more items. To do this:

1. Select the item or items you wish to delete. 

To select one item, click on it with your mouse. For details on selecting multiple map items, click 
Selecting Multiple Map Items.

2. Choose Delete Items from the Edit menu. The selected items are removed from the current map. 

You can also remove items from your system entirely (if you used the Read/Write installation option). 
Such items will no longer appear in the Place/Names dialog. 

WARNING:    You cannot undo this type of deletion. Once you have 
removed an item from the system, the only way to bring that item back
is by reinstalling American History Explorer or replacing it manually.

To delete an item from your system entirely,

1. Choose Find/Select Items from the Search menu or click on the Search icon. The Place/Names 
dialog opens.

2. Close the current map.

3. Select the item(s) you want to remove from the system and click the Delete button at the bottom 
of the dialog box.

For more information see:
Selecting Multiple Map Items 
Moving Map Items 
Working with Map Items 
Working with Maps 



 Finding Map Items

American History Explorer offers a quick method to locate map items on an open map. The key is using
the Search menu.

To find an item on the current map, 

1. Choose Find/Select Items from the Search menu (or click the Search icon on the icon bar).The 
Place/Names dialog opens.

2. Click on the Items On Current Map option to display a list of map items that appear on the current
map.

3. Mark the categories of items you want to list (cities, states, etc.).

4. Highlight the item(s) of interest on the map item list and click the Find button.

American History Explorer will automatically find your item and outline it on the map. The map 
will adjust to display the selected item in the Map window. You may need to move, size, or close 
the Place/Name dialog to see the item.

The Place/Names dialog remains open, ready for you to Find or Add other items. If you've 
completed your work, click on the Close button to close the dialog.

For more information see:
Limiting Categories 
Selecting Items from the Map Item List 
Selecting Items to Add to a Map 
Using the Map List Button 
Performing a Search 
Working with Map Items 
Working with Maps 



 Accessing Pictures

The more than 1,000 pictures in American History Explorer can be accessed from several locations in 
the program.

Viewing Pictures
If you just want to view a picture,

1. Click on the Picture Album icon on the Opening Screen. A Select Picture dialog box will open.

2. Select the picture you want to view and double-click on it to see it displayed on screen. (You can 
also highlight the picture and then click OK or press Enter on the keyboard.)

3. When you're done, double-click the Control-menu box or press Esc on the keyboard to close the 
picture and return to the Opening Screen.

Viewing Pictures from an Article
Many of the pictures in American History Explorer are used to illustrate articles and can be accessed 
directly from an Article window. To view a picture related to an article, 

1. From the Article window, double-click on the picture icon . The picture opens immediately in 
its own window.

2. When you're done viewing the picture, double-click the Control-menu box (or press Esc on the 
keyboard) to close the picture and return to the Article window.

For more information, see:
Viewing 3D Images 
Playing Movies and Slide Shows 



 Viewing 3D Images

American History Explorer includes a gallery of 3D images. These double or "stereo" images are similar
to those used by early Americans decades ago. The double illustrations were printed on cards and 
clipped to a "stereo" viewer so a person could trick his eyes into seeing a three-dimensional image. The 
effect is almost like being there!

To access these images, 

1. Click on the 3D Gallery icon on the Opening Screen.

2. Select the picture you want to view and double-click on it to see it displayed on screen. (You can 
also highlight the picture and then click OK or press Enter on the keyboard.)

3. When you're done, double-click the Control-menu box or press Esc on the keyboard to close the 
picture and return to the Opening Screen.

Once you have a 3D image displayed on screen, there are two ways you can view it: using the special 
glasses included in the American History Explorer package, or simply "free" viewing. For detailed 
instructions, click on the appropriate topic below. To see a good "practice" 3D image, refer to Page 9 in 
your Information Guide.

Viewing 3D Images with Glasses 
Free Viewing 3D Images 



 Accessing Videos

The videos in American History Explorer can be accessed from the Movie Theater on the Opening 
Screen or from a time line.

To start a video from the Movie Theater,

1. Click on the Movie Theater icon on the Opening Screen.

2. Click on the video you wish to view. (Titles displayed below each video will help you choose which
one you want.)The program will begin the video.

To start a video from a time line,

Click any video icon (displayed at the top of the time line screen. The program will begin the 
video.

For more information, see:
Adjusting Program Volume 
Stopping Videos 



 Accessing Slide Shows

The slide shows in American History Explorer can be accessed from the Slide Shows icon on the 
Opening Screen, from the Hall of Presidents, or from a Map window.

To start a slide show from the Opening Screen,

1. Click on the Slide Shows icon on the Opening Screen. The Select Slide Show dialog box 
appears. 

2. Find the slide show you wish to view (use the scroll bar, if necessary) and select it.

3. With the preferred slide show highlighted, click OK or press Enter on your keyboard. The 
program will begin the slide show.

(In place of steps 2 and 3, you can simply double-click on the preferred slide show.)

To start a slide show from a Map window,

1. Click the Slide Show icon on the icon bar. The slide show associated with the open map will begin
to play.

For more information, see:
Adjusting Program Volume 
Slide Show Controls 



 Stopping Videos

To stop a video before it is finished, click in the area immediately outside the viewing screen.

To stop a video and return to the previous screen, click the curl at the bottom right corner of the Movie 
Theater window.

For more information, see:
Adjusting Program Volume 



 Operating Slide Show Controls

You can rewind, stop, play, and fast forward an American History Explorer slide show as you view it. 
The control bar, displayed at the bottom of the slide window, operates the same as controls for tape 
players.

Click on any part of the illustration below for further information.

NOTE:    To exit the slide show without viewing the entire show, double-
click the Control-menu box. 

For more information, see:
Adjusting Program Volume 



 Opening the Song Book

The Song Book, available from the Opening Screen, plays music related to the Colonial and Civil War 
eras of American history.

To listen to a tune,

1. Click on the Song Book icon on the Opening Screen. The song list screen appears.

2. Click on any song. The program will begin playing the selected song. 

Exiting the Song
You can continue to work with American History Explorer while the song is being played. Just click the 
curl on the corner of the screen to exit the feature. You can work with most other program features while 
the song continues to play.

NOTE:    Because songs in the Song Book are recorded in stereo, a 
stereo sound card is required for this feature.

For more information, see:
Adjusting Program Volume 
About the Musicians 



 Rules for Playing 5Ws

The 5Ws Game is a quick way to test your knowledge of information included in the American History 
Explorer. Following is information on playing the game.

Game Selections

Select play for one or two players.

Select game length:
5 questions - each player receives five questions

10    questions - each player receives ten questions

Ask until player quits - game ends when player selects Quit

Scoring Points
Players receive 100 points for selecting a correct answer on the first try, 75 points on the second try, and 
so on.

For each hint given, 10 points are deducted from the potential 100 points. Note that if research is done 
before asking for a hint, no points are deducted.

Playing the Game
To play the 5Ws Game, 

1. Click Begin.

Player 1 is asked the first multiple choice question. Questions are randomly selected from a 
database of over 400 questions.

2. Player 1 can choose an answer, ask for a hint, or pass. By passing, the player gives up the 
chance to receive any points on that question.

USING HINTS:    If a player selects an incorrect answer, hints are 
automatically provided. Clicking on any of the icons to the left of a hint 
will bring up the map, article, or slide show that the player can research
for the answer. Once the player is finished researching, he or she can 
return to the game to choose another answer. Previously selected 
answers and hints are dimmed to track the player's choices. 

3. After Player 1 selects the correct answer or passes, Player 2 takes a turn (assuming the game is 
in Two Player mode). The red ball indicates whose turn it is. 

4. The game ends when five or ten questions have been asked or when the player(s) decide to quit. 

5. The final score is presented and the winner acknowledged.

For more information, see:
Working with Articles 
Working with Maps 
Slide Shows 
Time Lines 





 Opening a Time Line

To open a time line,

1. Click the Time Trek icon on the Opening Screen.

A row of blocks, depicting different time periods is presented on screen.

2. Select a time line period by clicking on the title or icon block that you wish to view.

The program presents the time line on screen.

For more information, see:
Tips on Scrolling 
Exiting a Time Line 
Accessing Items from a Time Line    



 Tips on Scrolling

When working with scrolling screens, such as time lines and the Hall of Presidents, you can scroll to 
undisplayed portions of the screen. 

To scroll left and right,

1. Move the cursor to the left or right edge of the screen until it turns to a solid arrow cursor.

2. Click the left mouse button and hold it down as you continue to bump the edge of the screen. The
program will scroll horizontally to display more of the screen.

NOTE:    When using the Compare Presidents feature, you move 
backward (to the left side of the screen) by clicking on the right side of 
the first, fixed column (of presidents' names), rather than the left edge 
of the screen.

For more information, see:
Opening a Time Line 
Exiting a Time Line 
Accessing Items from a Time Line    



 Accessing Items on a Time Line

Once you have a time line open, you can use it by simply scrolling through and viewing the titles of items 
along the time line, or you can explore a little deeper by actually accessing the items represented.

To access a Year article, other article, document, map, presidential profile, or video on a time line, 

Click on the appropriate icon (or any date on the line for a Year article). The selected item will 
open.

For more information, see:
Time Line Year Articles 
Tips on Scrolling 
Exiting a Time Line 
Opening a Time Line 



 Exiting a Time Line

To exit a time line,

Click the curl in the top right corner of the screen. You will be returned to the Time Trek cubes.

For more information, see:
Tips on Scrolling
Opening a Time Line 
Accessing Items from a Time Line    



 Print Setup

American History Explorer gives you the option to print maps and articles.

The program provides separate printer setup dialogs for maps and articles. This allows you to set your 
printer to print your maps in landscape mode (horizontal) and your articles in portrait mode (vertical), if 
you wish. With these as default settings, you don't have change the print setup every time you change 
what you're printing. 

Both of these printer setup procedures are exactly the same; only the option you choose from the menu to
perform the setup varies. 

To define the print settings for maps, click the Print Map icon on the icon bar (or you can select Print 
Setup from the Map menu if you used the Read/Write installation option). 

To define print settings for articles, click the Print Article icon on the icon bar (or you can select Print Setup
from the Article menu if you used the Read/Write installation option).

When you select any of these options, the Print Setup dialog appears. Here you can select the desired 
printer, page orientation, and paper size/source.

Depending on the printer you are using, an additional Options button may appear on the Print Setup 
dialog. The Options button allows you to modify a variety of print options unique to the selected printer. 
The options that appear will vary depending on the printer you are using. See your Windows manual for 
more information on print options.

For more information see:
Print Setup Dialog Box 
Printing Maps 
Printing Articles 



 Setting Fonts

When you select Font from the Font menu, or click the Font icon in an Article window, a Font Dialog Box 
is displayed. This box allows you to select the Font, Font Style, and Size of type for text that appears in 
your articles. Select the characteristics you want, then click OK. Any changes you make affect all articles.

You can select only one font at a time, so if you want to vary text within an article, you'll have to use text 
styles (Bold, Italic, Underline).

For more information see:
Font Characteristics 
Working with Articles 



 Menu Bar

If you selected the Read/Write installation when setting up American History Explorer, both the Map 
windows and Article windows will include a horizontal list of menu options along the top of their screens.

When you select any of these options, a pull-down menu appears listing choices. These pull-down menus
provide easy access to program features. 

You can access the menu bar menus using your keyboard or a mouse. To select a Main Menu option 
using your keyboard, press the Alt key plus the menu's underlined pick letter. To select a Main Menu 
option with your mouse, simply click on the desired option.

Menu bars are only available from the Map windows and Article windows.

For more information see:
Summary of Menu Options 
Screen Elements 
Icon Bar 
Map Window 
Article Window 



 Map Window

Whenever you open a new or existing map in American History Explorer, the map appears inside an 
active Map window. 

Moving and Resizing a Map Window
You can change the size and location of the window like any other window within a Microsoft Windows 
application. (For example, just point to any corner or border, and when the cursor changes to a two-
headed arrow, drag the corner or border until the window is the size you want. You can also click on the 
title bar and hold down the mouse button to drag the entire window to another position on the screen.)

When you move or resize the entire Map window, the map and its items adjust accordingly. In some 
cases, you may need to use the scroll bars on the sides of the window to view the entire map contents. 
See your Windows User's Guide for instructions on moving and resizing windows.

You can also open more than one window at a time. For example, while you have a Map window open, 
you can open an Article window. However, you can NOT open more than one Map window at the same 
time. 

Below is an illustration of the Map window. Click on any part of it for more information.

Closing a Map Window
To close a map and its Map window, do one of the following:



Select Close from the Map menu.

Click on the Close Map icon on the icon bar. 

Double-click on the Control-menu box in the upper left corner of the Map window.

For more information see:
Screen Elements 
Icon Bar 
Article Window 
Scroll Bars 



 Legends

American History Explorer has a map legend feature you can use to clarify the information contained on
a map. You can display the legend even with new maps. Below is an illustration of a map legend.

A map legend can illustrate the following:

Map events--the historical events depicted on a map. (Map events are defined by the user in the 
Map Legend dialog box. To open the dialog, select Edit Legend from the Edit menu.)

Distance scale--the scale factor for the map's background. The increments on the distance scale
will vary depending on the map's background and the zoom level you currently have selected.

Elevation scale--a key for the elevation scheme used on a map (this is preset for you and only 
appears for topographic maps).

For more information see:
Editing Legends 
Screen Elements 
Map window 



 Scroll Bars

Like most Windows applications, American History Explorer contains some windows with scroll bars 
you can use to view additional information that does not fit on the screen. You can use the arrow buttons 
to move one line at a time or click and hold an arrow button to scroll continuously. You can also click and 
drag the box on the scroll bar to move to another location within the window. Click above or below the box
on the scroll bar to jump about one screen.

For more information see:
Screen Elements 
Icon Bar 
Map Window 
Article Window 
Scrolling Through Maps 
Menu Bar 



 Status Bar

The status bar appears at the very bottom of the Map windows. The status bar displays important 
information as you work with the program. 

In the Map window, it has three segments: a help/information segment on the left, a distance meter in the 
center, and a latitude/longitude indicator on the right. 

The help/information segment contains hints for operating the program, information on menu 
options, and important messages at certain program locations.

The distance meter displays the distance between two or more points when you use the distance 
measurement feature. (For details on this feature, click on Measuring Distance on a Map.

The latitude/longitude indicator reflects the current location of the cursor (such as a selected city, 
for example).

For more information see:
Screen Elements 
Settings Dialog Box    
Icon Bar 
Map Window 
Article Window 
Scroll Bars 



 Toolbox

The Toolbox allows you to add graphics to any American History Explorer map. You can draw lines, 
circles, squares, and other shapes, specifying the size and color of each to suit your needs. The Toolbox 
also allows you to move, resize, copy, and delete graphics. 

You can access the Toolbox from any Map window by selecting the Graphic Tools option on the Edit menu
(or by clicking the Toolbox icon on the icon bar).

The buttons on the top of the Toolbox allow you to select the type of line or shape you want to create. You
can select the arrow and hand cursors from the Toolbox as well. The arrow cursor allows you to draw 
lines and shapes, resize graphics, and select graphics. The hand cursor allows you to select and move 
graphics.

Other options on the Toolbox allow you to select the colors and line width for your lines and fill patterns 
and colors for shapes. If you have graphics that overlap, you can choose which item to place on top. You 
also have the option to copy, save, and move any map graphics. 

Click on any part of the illustration below for a description of its function.

For more information on using the Toolbox to create graphics, click Inserting Graphics into a Map.

For more information see:
Drawing Lines 
Drawing Shapes 
Inserting Graphics into a Map 
Selecting Graphics 
Arranging Graphics 
Copying Graphics 
Moving Graphics 



Deleting Graphics 
Resizing Graphics 
Reusing graphics with the Add Graphics dialog box 



 Desktop Window

The American History Explorer desktop may contain one or more windows. For example, you may have
one article, one map, one picture, and a Search dialog box open on your desktop at the same time.

You cannot have multiple windows of any single feature. For example, you cannot have two maps open at
the same time. 

For more information see:
Screen Elements 
Icon Bar 
Map Window 
Article Window 
Scroll Bars 



 Minimize Button

This button displays a small down arrow and is located second from the right in the upper right corner of 
any Map window, Article window, and on pictures and 3D images.

Clicking on the Minimize button reduces the current map, article, or picture to an icon on the American 
History Explorer desktop. 

To restore the map, article, or picture, you can double-click on the icon (or click once on the icon and 
select the Maximize or Restore from the control-menu box to do this.)

For more information see:
Screen Elements 
Settings Dialog Box    
Icon Bar 
Map Window 
Article Window 
Scroll Bars 



 Maximize Button

This button displays a small up arrow and is located in the far, upper right corner of any Map or Article 
window. Clicking on this button increases the size of the map or article so that is covers the whole 
American History Explorer desktop area. 

Whenever a map or an article is maximized, the Maximize button changes to an up and down arrow 
symbol. You can click on this icon to return the window to its previous size.

For more information see:
Screen Elements 
Settings Dialog Box    
Icon Bar 
Map Window 
Article Window 
Scroll Bars 



 Installation Options

During the installation of American History Explorer, you'll be given a choice of operating the program in
a Read Only Version or a Read/Write Version. To switch between these options, you can re-install the 
program at any time. Following is an outline of the differences between the two options.

Read Only Version
This version is designed for those with precious little hard drive space (it requires approximately 2 
megabytes) and who only want to refer to the information. With this version, you can open, close, and 
print maps and articles or view the slide shows and videos, but you can NOT make changes to any items.
This "noneditable" version leaves all the data files on the CD ROM and will probably run slightly slower on
certain features. 

With this version, your Map windows and Article windows do not display a menu bar. In addition four icon 
bar buttons in the Map window are not available. The omitted buttons are Arrow Cursor, Hand Cursor, Edit
Map Item, and Edit or Create Map Graphics.

Read/Write Version
This version is designed for maximum interaction and most users to combine information from several 
sources to write a report or edit a map. With this version, you can write new articles and design your own 
maps, you can cut and paste information from one place to another, you can change or delete items. This 
"editable" version copies all the data files from the CD to your hard drive (requires approximately 9 
megabytes) and will probably run slightly faster on certain features.

For more information see:
Basic Information 



 Map Item List

For a list of all cities, regions, events, geographical features, people, and other miscellaneous map items 
available in American History Explorer, use the Map Item List, available in the Place/Names dialog box.

Access this dialog by selecting Find/Select Items from the Search menu or by clicking the Search icon on 
the icon bar of any Map window. 

You can elect to display either a list of the specific items that appear on the current map or a list of all the 
program's items that do NOT appear on the current map. 

To select which list you want to see, click on Items On Current Map or Items In Database But NOT On 
Current Map, as is appropriate.

From the Place/Names dialog box you can use the Map Item List to:

Review a list of items on the current map.

Review a list of items NOT on the current map.

Add items to the current map.

Find an item on the current map.

Access a list of maps containing a selected place or name.

Permanently delete places and names from the American History Explorer database (with 
Read/Write installation option only).
For more information on the options available for this dialog, click the appropriate topic below.

Limiting Categories 
Selecting Items from the Map Item List 
Selecting Items to Add to a Map 
Finding an Item on the Current Map 
Using the Map List Button 



 Copying Articles

To copy the open article, 

1. Select Save As from the Article menu. 

2. In the Save As dialog box that appears, enter a name for the new (copied) article and click OK.

The original article will be retained and a new copy will be added to your program database.

For details on using this option, click Saving Articles.

For more information see:
Editing Articles 
Working with Articles 



 Defining Font Characteristics

The Bold, Italic, and Underline options on the Font menu allow you to assign those font characteristics to 
text within an article. 

To change a font characteristic, 

1. Place the article in the Edit mode by selecting Edit Mode from the Edit menu.

2. Select (highlight) the text you wish to modify. 

3. Choose Bold, Italic, Underline, or combinations of the three from the Font menu. The selected 
text will change appearance according to your specifications.

The default font characteristics can also be changed at any time by selecting Font from the Font menu 
and making the choices from the Font dialog.

NOTE: You cannot change the font characteristics of words used as 
links since those words have been assigned special characteristics 
essential to the linking process. (Click Linking Text to an Article for 
details.)

You can also change the color of article links used in an article. For details, click on Changing Link Color.

For more information see:
Editing Articles 
Saving Articles 
Working with Articles 



 Selecting Items to Add to a Map

If you want to add an item (such as city or battle site) to a map, the Map Item List in the Place/Names 
dialog box allows you to select from a list of existing map items. To access this dialog, select Find/Select 
Items from the Search menu. Use the following steps to select an item to add to a map:

1. At the top of the Place/Names dialog, select the option "Items in Database But NOT Found On 
Current Map." This displays the Map Item List on the left of the dialog box. 

2. From the Map Item List, select the item(s) you want, then click the Add button. 

(You can select multiple items by clicking and dragging or by pressing the Shift or Ctrl keys as 
you click. Click on Selecting Map Items for more information on selecting multiple items.) 

The items are added to your map. The Place/Names dialog remains active so you can add additional 
items or perform other functions, if needed.

NOTE:    If the item you added cannot be placed on the map because its
coordinates lie outside of the map's boundaries, after you click the Add 
button, a Message dialog will appear indicating the selected item 
cannot be viewed on the existing map. You can place the item anyway 
or cancel the selection.

3. When you are done, click the Close button to close the dialog and return to your map. The new 
item is positioned appropriately on the map.

For more information see:
Creating Your Own Map Items 
Working with Map Items 
Working with Maps 



 Smart Picker

American History Explorer contains a "smart picker" function that allows you to select from a pick list by
typing only an item's first few letters.

For example, to open an article from the Select Article dialog, type the first few letters of the name of the 
article you want to open into the box above the articles list. The highlight automatically moves to this 
article, and you can now click OK or press Enter to open it.

For more information see:
Data Entry Procedures 
Data Entry Keys 
Deleting Data 
Entering New Field Information 
Marking Fields 
Using the Windows Clipboard Options 
Keyboard Commands 
Mouse Operations 



 Selecting Parts of a Map

You can select a portion of a map using the RIGHT mouse button. You can then copy the selected area to
the Windows Clipboard and export it to a graphics file or zoom in on or print the selected area only. 

To select a portion of a map,

1. With the selected map open, click the arrow cursor icon on the icon bar.

2. Position the cursor where you want to begin.

3. Click and hold the right button on your mouse as you drag the outline over the area you want to 
select.

4. When you've defined the area you want, release the mouse button. The specified area is 
selected. 

Now you can manipulate the map as you wish.

    To copy the selected map portion to the Windows Clipboard, click the Copy Map icon or 
select Copy from the Edit menu.

    To zoom in on the selected area, click the Zoom icon or select Zoom from the Options 
menu.

    To print the selected area, click the Print Map icon or select Print from the Map menu and 
choose Selected Rectangle.

For more information see:
Copying Maps to the Windows Clipboard
Zooming Selected Areas on a Map 
Printing Maps 
Saving a Map 
Working with Maps 



 Data Entry Keys

Some common cursor-movement and editing keys are listed here. These keys operate as indicated in 
most data entry fields:

Left Arrow    Moves the cursor one position to the left.

Right Arrow    Moves the cursor one position to the right.

Home    Moves the cursor to the beginning of a field.

End    Moves the cursor to the end of a field.

Del    Deletes the character in the current cursor position.

For more information see:
Data Entry Procedures 
Deleting Data 
Entering New Field Information 
Marking Fields 
Using the Windows Clipboard Options 
Keyboard Commands 
Mouse Operations 
Smart Picker 



 Deleting Data

To erase data from a data entry field on a dialog box,

1. Select the data to be deleted by dragging the cursor over the desired text.

2. Press the Del key or the spacebar to delete the entire entry.

You can also erase entries character by character (without selecting any text) by pressing the Del or 
Backspace key repeatedly.

For more information see:
Data Entry Procedures 
Data Entry Keys 
Entering New Field Information 
Marking Fields 
Using the Windows Clipboard Options 
Keyboard Commands 
Mouse Operations 
Smart Picker 



 Entering New Field Information

Initially, a data entry field on a dialog box can be empty or it may contain preset or default characters.

To accept the data currently displayed in the field, 

Position the highlight on the desired field and press Tab. The entry is accepted and the highlight 
moves to the next field.
To enter a different option, do one of the following:

With the highlight positioned on the desired field, use the keyboard to type in the appropriate 
information, then press Tab to accept your entry and move to the next field.

Click on the down arrow at the right end of many data entry fields to view a list of available 
choices. From this list, you can click on any option to select it. Your choice appears in the data entry field. 
Press Tab to accept the entry and move to the next field.

For more information see:
Data Entry Procedures 
Data Entry Keys 
Deleting Data 
Marking Fields 
Using the Windows Clipboard Options 
Keyboard Commands 
Mouse Operations 
Smart Picker 



 Marking Fields

On many dialog boxes, you need to choose from a list of features or indicate whether optional information
should be included. You will encounter three slightly different versions of this type of field:

Check Boxes
On some dialog boxes, you will notice check boxes that allow you to select or deselect an item (usually a 
display option). For example, the Map Legend dialog box (accessed by selecting Edit Legend from the 
Edit menu) contains several check boxes at the top that you can use to display/hide various items on the 
map legend. When you click on a check box with your mouse, an "X" appears in the box. 

Frequently, one or more items will be checked by default. To change the selection, move the cursor to the 
box in front of the option of interest and press the spacebar (or click on it with your mouse). If the item 
was previously selected, the "X" is removed from the box. If the item was not selected, an "X" appears in 
the box.

Radio Buttons
Some dialog boxes also contain circular radio buttons that allow you to select a particular option. For 
example, when you select Open from the Map menu of a Map window, a Select Map dialog appears 
where you can use radio buttons to view the list of existing maps in alphabetic or chronological order. 

Radio buttons are used for options where you can make only ONE choice. Sometimes, radio buttons are 
selected by default, but you can change this by clicking on another radio button. The selection will move 
from the default to your new choice. You cannot deselect a radio button by clicking on it; you must select 
another option.

Colored Highlight Bar
Throughout American History Explorer, some program features allow you to select one or more options 
using the highlight bar. You can select items using the keyboard or your mouse. For example, when you 
are selecting a map to open, you can click on the desired map or use the up and down arrow keys on 
your keyboard to select it. You can then click OK to open the map. On some dialogs, such as the 
Place/Names dialog, you can select more than one item at a time. For more information on selecting 
items from this dialog, click Selecting Items from the Map Item List.

For more information see:
Data Entry Procedures 
Data Entry Keys 
Deleting Data 
Entering New Field Information 
Using the Windows Clipboard Options 
Keyboard Commands 
Mouse Operations 
Smart Picker 



 Using the Windows Clipboard Options

You can use Windows Clipboard options to perform various functions in an Article window. For example, 
you can undo the last action performed, cut or copy selected text from an article, and paste text from the 
Clipboard into an article. All of these options are accessible from the Edit menu of any Article window.

You can also use the following keyboard commands to perform each operation:

Undo Ctrl+Z

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

NOTE:    You can also use the Copy Article icon on the icon bar to copy 
the article text to the Windows Clipboard.

For more information see:
Data Entry Procedures 
Data Entry Keys 
Deleting Data 
Entering New Field Information 
Marking Fields 
Keyboard Commands 
Mouse Operations 
Smart Picker 
Edit Menu for Maps 
Edit Menu for Articles 
Copying Maps to the Windows Clipboard 
Editing Articles 



 Keyboard Commands

You can select some American History Explorer options using either the keyboard or a Microsoft (or 
compatible) mouse. 

The keyboard movements used in the program are typical of those found in many software programs. For
example, next to some menu options on a pull-down menu, there are shortcut keys listed. You can use 
these shortcut keys to quickly access program features by pressing the appropriate key(s) on your 
keyboard.

NOTE:    Although you can select many options in American History 
Explorer using a keyboard or a mouse, a Microsoft (or compatible) 
mouse is still required to operate the program. Some features of the 
program, such as accessing options from the Opening Screen and 
measuring distance between two or more points on a map, can only be 
performed with a mouse.

For more information see:
Data Entry Procedures 
Data Entry Keys 
Deleting Data 
Entering New Field Information 
Marking Fields 
Using the Windows Clipboard Options 
Mouse Operations 
Smart Picker 



 Mouse Operations

Some American History Explorer options can be selected using either the keyboard or a Microsoft (or 
compatible) mouse. 

Before you can run American History Explorer, make sure the "mouse driver" software provided with 
the mouse has been properly installed. Refer to the installation instructions included with the mouse 
package.

Because most Windows users tend to use a mouse, we emphasize mouse operation in our program 
documentation and in the online Help. If you are new to mouse operations, please refer to your Windows 
manual for assistance.

NOTE:    Although many options in American History Explorer can be
selected using a keyboard, a Microsoft (or compatible) mouse is still 
required to operate the program. Some features of the program, such 
as measuring distance between two or more points on a map, can only 
be performed with a mouse.

For more information see:
Data Entry Procedures 
Data Entry Keys 
Deleting Data 
Entering New Field Information 
Marking Fields 
Using the Windows Clipboard Options 
Keyboard Commands 
Smart Picker 



 Edit Map Item Dialog Box

This dialog box opens when you click on the Edit Map Item icon from a Map window or select Create New
Item or Edit Items from the Map menu. 

The Create New Item option allows you to add map items to a map. The Edit Items option allows you to 
edit a selected map item. The following paragraphs explain the fields contained on the Edit Map Item 
dialog box and what to enter (or select) for each field.

Name--enter a name for the map item. The name you enter will appear on maps as entered here and is 
used to reference the item, so you can insert it on other maps later if you like (via the Map Item List). 
Therefore, you need to enter a name for the item, even if you choose not to display it on your map. If you 
want to enter notes about the item, you can insert the information after the name within parentheses. 
(Anything within parentheses won't appear on the map, but will appear in the Place/Names dialog.)

Font/Size/Style/Color--select the font type, size, color, and style (regular, bold, etc.) for the map item. 
You can type your choice for each into the appropriate field or click the down arrow beside the field to 
select an item from the list of available options. When you enter or modify font characteristics, an example
appears in the box in the lower left corner of the dialog.

Rotate Name--specify the angle at which the name should be displayed. You can rotate the name to 
display it at an angle or to display it vertically instead of horizontally. You can enter your choice (from 0 to 
360) or you can click the down arrow beside the input field to select from the list of available choices. An 
example of how the name will appear is displayed in the box in the lower left corner of the dialog.

Underline/Strikeout--these check boxes allow you to underline or strikeout the name for the map item. 
To use one of these options, click the appropriate checkbox using the spacebar or your mouse.

Icon/Size/Color--select the icon to be displayed on the map as well as the size and color for the icon. You
can enter your choice into the appropriate input field or you can click the down arrow beside the field to 
select from the list of available choices. An example of your selections appears in the box to the right. If 
you do not want an icon to display on the map, select the appropriate display option (see Display Options 
below).

Text Article--select the article to be attached to the map item. You can leave this blank if you want to 
create your own article and add it here later.

Category--define the type of item you are inserting by selecting the appropriate category from the 
category list provided. On the Place/Names dialog, you can use categories to sort items displayed on a 
map. You can limit the items displayed (by city, region, etc.).

Display Options--specify what is to be displayed on the map: name and icon, name only, or icon only.

Location--designate the exact location for the map item by entering the appropriate latitude and 
longitude. The settings displayed reflect the current location of the map item (based on the location you 
choose).

Change item(s) on all maps--indicate whether or not you want the changes made for this map item to be
modified on all maps containing this item. This field only appears if you are editing a map item (it will not 
appear if you are creating a map item). Check this box using the spacebar or your mouse to change this 
item on all maps as indicated. If you have checked this box, when you click OK to accept your entries, a 
Select Attributes to Change dialog appears where you can verify/select the types of modifications to be 
made.

For more information see:
Editing Map Items 
Map Item List    
Select Attributes to Change Dialog 





 Map Legend Dialog Box

The Map Legend dialog box allows you to modify the information displayed on a map's legend. You 
access this dialog by opening a map, then selecting Edit Legend from the Edit menu. The following 
paragraphs explain the fields contained on the Map Legend dialog box and what to enter (or select) for 
each field.

Print map name--Check this box to have the name of the map printed at the top of the legend when you 
print the map. To check and uncheck this box, use the spacebar or your mouse.

Display distance scale--Check this box to display the distance scale on the legend. The increments on 
the distance scale vary depending on the map's background and the zoom level you currently have 
selected. To check and uncheck this box, use the spacebar or your mouse.

Display elevation scale--Check this box if you want the elevation scale displayed on the legend for 
topographic maps. The elevation scale does not display on non-topographic maps. Check and uncheck 
the box by using the spacebar or your mouse.

Label (Font/Color/Style)--Use these fields to define the font characteristics for each item displayed on 
the legend. You will use these options in conjunction with the Legend Items boxes at the bottom of the 
dialog. You can enter the text into one of the fields, then select the appropriate font characteristics. You 
can enter your choices into the appropriate fields or click the down arrow beside a field to select a choice 
from the list of available options. An example of how the Legend Item will appear is shown at the bottom 
of the Map Legend dialog.

Underline/Strikeout--These check boxes allow you to underline or strikeout text in a Legend Item field. 
To use one of these options, highlight the desired text in a Legend Item field, then mark the appropriate 
check box using the spacebar or your mouse.

Icon (Type/Color)--These options allow you to select the icon type and color that you want displayed for 
a particular Legend Item. By default, the Dot icon is selected for each Legend Item you create. To select 
another icon, click on the down arrow beside the Type field, then click the desired icon. You can enter 
your choices for these fields or click the down arrow beside a field to select from the available options. An 
example of how the Legend Item will appear is shown at the bottom of the Map Legend dialog.

Hide the Icon--Check this box if you do not want an icon displayed for a particular Legend Item. You can 
check and uncheck this box using the spacebar or your mouse.

Legend Items--The eight boxes that appear in the Legend Items section of the dialog allow you to enter 
text that will appear on the legend. Most maps included with the program list the events depicted on the 
map as Legend Items. You can use the Label options that appear above the Legend Items boxes to 
define the font characteristics for the text you enter. An example of how each Legend Item will appear is 
shown at the bottom of the Map Legend dialog.

For more information see:
Editing the Map Legend 



 Merge Maps Dialog Box

The Merge Maps dialog box allows you to merge the items from a selected map with the current map. 
This dialog appears when you select Merge Maps from the Edit menu of a Map window.

The Merge Maps dialog contains a list of existing maps and looks very similar to the Select Map dialog 
you see when you are opening a map. However, additional information is displayed at the top of the 
Merge Maps dialog. This information lists the background for the current map to give you an idea of the 
region represented by the current map, so you can make an appropriate selection.

You can use the scroll bars (or the up and down arrow keys on your keyboard) to scroll through the list. To
select a map to merge with the current one, do one of the following:

Click on the desired map with your mouse.

Use the up and down arrow keys.

Type the first few letters of the map's name into the input field above the list.
After you've selected the desired map, click OK or press Enter. The items from the selected map are 
merged with the current map. (You can also double-click on a map on the Merge Maps dialog box to 
select it and merge its contents with the current map in one step. In this case, you do not need to click the
OK button.)

NOTE:    At any time, you can click Cancel on the Merge Maps dialog to 
return to your original place in the program.

For more information see:
Merging Maps 



 Place/Names Dialog Box

This dialog box appears when you select Find/Select Items from the Search menu of a Map window or 
click the Search icon on the map's icon bar.

The Place/Names dialog box allows you to access a list of all cities, regions, events, geographical 
features, people, and other miscellaneous map items available in American History Explorer. You can 
elect to display:

A list of the specific items that appear on the current map.

A list of all the map items that are in the database but do NOT appear on the current map. 
To select which list you want to see, click on Items On Current Map or Items In Database But NOT On 
Current Map, as is appropriate. 

From the Place/Names dialog box you can:

Review a list of items on the current map.

Review a list of items NOT on the current map.

Add items to the current map.

Find an item on the current map.

Access a list of maps containing a selected place or name.

Permanently delete places and names from the American History Explorer database (if you're 
using the Read/Write installation option).
For more information on the options available for this dialog, click the appropriate topic below.

Limiting Categories 
Selecting Items from the Map Item List 
Selecting Items to Add to a Map 
Finding an Item on the Current Map 
Using the Map List Button 



 Print Dialog Box for Maps

When you select Print from the Map menu of a Map window (or click the Print Map icon), a Print dialog 
appears. (If you are in Read Only mode, the Print Setup dialog appears when you click the Print icon. 
When you click OK in Print Setup, the Print dialog appears.) 

On this dialog, you can specify the print options for the map being printed. The following paragraphs 
explain the options available on this dialog. Note that if you want to modify the page orientation--to print 
the map in landscape, for example--you need to use the Print Setup option on the Map menu; click Print 
Setup for details.

Area--specify the area of the map you want printed. Available options include: Selected Rectangle, 
Current Window, or Entire Map. The Selected Rectangle option is available only if you have selected an 
area on the map to be printed prior to accessing the Print option. (Click Selecting Portions of a Map for 
details on selecting an area of a map.) 

The Current Window option will print only the contents of the active Map window. The Entire Map option 
adjusts the whole map (including those portions not currently shown on screen) to fit within the confines of
the margins you specify.

HINT:    The Selected Rectangle and Current Window print options give 
you more control over the appearance of the image printed. Before 
printing the map, you can set the zoom level and map position to your 
liking, for example. Then when you print the map, it will be printed 
exactly as it appears on screen.

Margins--define the top, bottom, left, and right margins for the map. The program adjusts the map to fit 
on the page based on the margins you specify. Therefore, larger margins will make the map appear 
smaller and smaller margins will make the map appear larger. 

NOTE: The program will print the map as closely to the selected 
margins as possible. However, the right and bottom margins may be 
somewhat larger than specified depending on the print settings you 
have selected.

Style--indicate whether you want the map to be gray scaled (printed in various shades of gray), printed 
only in black and white, or printed in color. The Color option is available only if you are using a color 
printer.

Print event markers--indicate whether or not you want the events depicted on the current map to be 
printed. To print any events shown on the current map, use the spacebar or your mouse to check this 
checkbox. Leave this box unchecked if you do not want events printed on the current map. (Only the 
cities, regions, geographical features, etc. will be printed.)

For more information see:
Print Setup 
Print Setup Dialog Box 
Printing Maps 



 Save As Dialog Box (for articles)

This dialog box opens when you select Save As from the Article menu of an Article window. It also 
appears the first time you save an article you've written.

The Save As dialog allows you to enter a name for a new article. You can enter any name (up to 60 
characters). When entering a name, you can use any keyboard character and can include spaces to 
separate words if you like. After you've entered the desired name, click OK to save the article under the 
name you entered. Or, you can click Cancel to cancel the selection (without saving the article) and return 
to the current window.

For more information see:
Saving an Article 



 Save As Dialog Box (for maps)

This dialog box appears whenever you select Save (on a new map) or Save As from the Map menu of a 
Map window.

The Save As Dialog Box can be used to:

Save a user-defined map (one you created) for the first time (if you choose Save from the Map 
menu).

 Make a copy of the current map (if you choose Save As from the Map menu).
When the Save As dialog appears, you can enter a name and a time period for the map.

Choosing a Map Name
In the name field, you can enter a name of up to 60 characters for your map. You can use any keyboard 
character and can include spaces to separate words if you like. You can click the down arrow beside the 
name field (or press the down arrow on your keyboard) to view a list of existing map names.

Adding a Time Period
You can also enter a date to indicate the time period of the map if you like. This date is used for sorting 
maps chronologically on the Select Map dialog.

The program recognizes standard month abbreviations as well as most standard date abbreviating 
formats (for example, 7/4/1776; or July 4, 1776; or 7-4-1776); however, you must enter all four digits of 
the year (1776, not '76). Maps covering a range of dates are sorted chronologically.

Saving the Map
After you've entered the appropriate information (note that the name is required, but the time period is 
optional), click OK to save the map under the name you entered. Or, you can click Cancel to cancel the 
selection (without saving the map) and return to the current window.

For more information, see:
Creating a Map 
Working with Maps 



 Select Article Dialog Box

This dialog box appears when you click the Source Book icon on the Opening Screen, click the Open 
Article icon of an Article window, or select Open from the Article menu of an Article window. 

Use the Select Article dialog to access any of the nearly 1,400 articles in the American History Explorer 
database. 

On the dialog, you'll see a list of existing articles. This list contains all the articles included with the 
program plus any you've created. You can use the scroll bars (or the up and down arrow keys on your 
keyboard) to scroll through the list. To select an article, do one of the following:

Click on the desired article with your mouse.

Use the up and down arrow keys.

Type the first few letters of the article's name into the input field above the list.
After you've selected the desired article, click OK. The selected article opens on screen in an Article 
window.

NOTE:    You can click the Cancel button on the Select Article dialog box
at any time to void the operation and return to your original place in the
program.

For more information see:
Associating Articles with a Map 
Viewing Articles 



 Select Attributes to Change Dialog Box

The Select Attributes to Change dialog box appears if you have checked the Change item(s) on all maps 
check box on the Edit Map Item dialog box. 

The Select Attributes to Change dialog box outlines the types of modifications you made to the map item 
(name, font, icon, text article attached, etc.) and gives you an opportunity to select the items you want 
changed. Each area you have changed is automatically selected by default; you can deselect the items 
you don't want to change by using the spacebar or your mouse. 

The following outlines each of the check boxes listed on the dialog along with a description of the 
information the check box represents.

Name--the name of the item.

Display Options--the information to be displayed for the map item (name and icon, name only, 
icon only).

Text Article--the article associated with the map item.

Category--the type classification for the map item (city, event, geographic, misc., people, region, 
or state).

Location--the latitude and longitude for the map item.

Font--the type, size, angle, style, color, and underline/strikeout selections for the name of the 
map item.

Icon--the type, size, and color for the icon to be displayed for the map item.

Click OK when you're done, to update all maps and return to the Map window. Or, click Cancel to return to
the Edit Map Item dialog box.

For more information see:
Editing Map Items 



 Select Background Dialog Box

When you choose New from the Map menu, a Select Background dialog appears where you can select 
the background for the map you're creating. 

You can use the scroll bars (or the up and down arrow keys on your keyboard) to scroll through the list of 
available backgrounds. To select a background on the dialog, do one of the following:

Click on the desired background with your mouse.

Use the up and down arrow keys.

Type the first few letters of the background's name into the input field above the list.
After you've selected the desired background, click OK. The selected background opens on screen in a 
Map window. (You can also double click on a background on the Select Background dialog box to select it
and open it in one step. In this case, you do not need to click the OK button.)

NOTE:    At any time, you can click Cancel on the Select Background 
dialog to return to your original place in the program.

For more information see:
Creating a Map 



 Link Article Dialog Box

The Link Article dialog box allows you to pick an article to link to selected text in the open article. This 
dialog box appears when you are editing an article. You must first select text (by highlighting it with your 
mouse), then choose Link from the Links menu.

On the dialog, you'll see a list of existing articles. This list contains all the articles included with the 
program plus any you've created. You can use the scroll bars (or the up and down arrow keys on your 
keyboard) to scroll through the list. To select an article, do one of the following:

Click on the desired article with your mouse.

Use the up and down arrow keys.

Type the first few letters of the article's name into the input field above the list.
After you've selected the desired article, click OK. The specified article is linked to the selected text within 
the current article. The link is enabled and the text changes to the color of other linked items. (You can 
also double click on an article on the Link Article dialog box to select it and link it in one step. In this case, 
you do not need to click the OK button.)

NOTE:    You can click the Cancel button on the Link Article dialog box 
at any time to void the operation and return to the article.

For more information see:
Linking Text in an Article 
Viewing Articles 



 Select Map Dialog Box

The Select Map dialog box allows you to select a map to open on screen.

This dialog appears when you click the Map Studio icon on the Opening Screen, choose Open from the 
Map menu of any Map window, or click the Open Map icon on a Map window icon bar. 

The Select Maps dialog contains a list of existing maps. You can use the scroll bars (or the up and down 
arrow keys on your keyboard) to scroll through the list of available maps. 

Most maps included with the program are associated with a time period, indicating the era of the map. 
Initially, the Select Map dialog lists maps in alphabetical order. However, you can also choose to sort them
in time period order if you like (which will display appropriate date first, followed by the map name). Just 
click on the option you prefer.

To select a map to open, do one of the following:

Click on the desired map with your mouse.

Use the up and down arrow keys to highlight the desired map.

Type the first few letters of the map's name into the input field above the list.
After you've selected the desired map, click OK (or press Enter). The selected map opens on screen in a 
Map window. (You can also double click on a map on the Select Map dialog box to select it and open it in 
one step. In this case, you do not need to click the OK button.)

NOTE:    At any time, you can click Cancel on the Select Map dialog to 
return to your original place in the program.

For more information see:
Opening a Map 



 Swap Backgrounds Dialog Box

The Swap Background dialog box allows you to change the background for the current map. This dialog 
appears when you choose Swap Backgrounds from the Edit menu with a map currently active on screen. 

The name of the current background is listed at the top of the dialog. This will help you select an 
appropriate background.

For example, to switch from a map displaying a U.S. medium background to a background of the same 
area displaying only the topography, you would choose a U.S. Medium Topographic background. (Note 
that in this case, the U.S Medium background would not appear as an option on the Select Backgrounds 
dialog since it's already in use.)

To select a background on the dialog, do one of the following:

Click on the desired background with your mouse.

Use the up and down arrow keys.

Type the first few letters of the background's name into the input field above the list.
After you've selected the desired background, click OK. The map's current background is replaced by the 
selected background. (You can also double click on a background on the Swap Backgrounds dialog box 
to select it and replace the current background in one step. In this case, you do not need to click the OK 
button.)

NOTE:    At any time, you can click Cancel on the Swap Backgrounds 
dialog to return to your original place in the program.

For more information see:
Changing the Map Background 



 Zoom Map Dialog Box

The Zoom Map dialog box allows you to modify the zoom level for the current map. This dialog appears 
when you select Zoom from the Options menu or click the Zoom Map icon. 

The current zoom level displays near the right center of the box. You can adjust the zoom level by typing 
a value directly into the Set Level field or by using the Zoom In/Zoom Out scroll bar on the left side of the 
box.

You can set values from 0.25 (zoomed out to reveal the largest area of the map) to 1.5 (zoomed in to 
show the smallest area). When you're satisfied with the setting, click OK. Depending upon your computer 
system and the degree of change, the modification may take several moments to implement. (Note that 
you can click the Cancel button on the Zoom Map dialog at any time to void the current operation and 
return to your original place in the program.)

NOTE:    If you zoom your map out to such a degree that any text on it 
would be impossible to read, the text may not be displayed at all. Do 
not be concerned. The information has not been deleted and will 
reappear again when you zoom back in.

For more information, see:
Zooming a Selected Map Area 
Working with Maps 



 Unlinking Text Within an Article

To remove a link within an article that may not be appropriate or is no longer needed:

1. Open the article to be modified.

2. If needed, activate the Edit mode by choosing Edit Mode from the Edit menu. (If you are already 
in the Edit mode and a check mark appears next to this menu option, skip this step.)

3. Highlight the item within the article to be unlinked and choose Unlink from the Links menu. The 
text returns to its normal display characteristics and the link is removed.

For more information see:
Linking Text to an Article 
Associating Articles with Maps 
Associating Articles with Map Items 
Saving Articles 



 Inserting Graphics into a Map

American History Explorer's Toolbox lets you create your own graphics to add to maps; and you can 
insert previously created graphics, too. For example, you might draw a circle or box around a point of 
interest or a group of events to draw attention to them.

To activate the Toolbox, select Graphic Tools from the Edit menu of any Map window (or click on the 
Toolbox icon on the icon bar). To disable the Toolbox, reselect this menu option or click the Toolbox icon 
again.

Toolbox Elements
The buttons on the top of the Toolbox allow you to select the type of line or shape you want to create. You
can select the arrow and hand cursors from the Toolbox as well. 

The arrow cursor allows you to draw lines and shapes, resize graphics, and select graphics.

The hand cursor allows you to select and move graphics. 

Other options on the Toolbox allow you to select the colors and width for your lines, and fill patterns and 
colors for shapes. You can also access the Add Graphics dialog which allows you to insert previously 
created graphics. If you have graphics that overlap, you can choose which item to place on top. You also 
have the option to copy, save, and move any map graphics.

For detailed information about the features available from the Toolbox, click on Toolbox. More information 
is included in the topics listed below. Click on the appropriate topic for more information.

For more information see:
Drawing Lines 
Drawing Shapes 
Inserting Graphics into a Map 
Selecting Graphics 
Arranging Graphics 
Copying Graphics 
Moving Graphics 
Deleting Graphics 
Resizing Graphics 
Reusing graphics with the Add Graphics dialog box 



 Selecting Items from the Map Item List

On the Place/Names dialog box, you can select items from the map item list in several ways. Once you've
selected an item, you can add it to the current map, find it on the current map, or access a map list for the
selected item. 

The following paragraphs outline how to select one or more items from the map item list:

Selecting a Single Item
To select a single item, use one of the following methods:

Click on its name in the Place/Names list. 

Enter the first few letters of the item in the data entry field above the list to move near the item's 
location in the list quickly.

Selecting Nonconsecutive Items
To select several nonconsecutive items from the list, 

Press and hold the Ctrl key as you click on the various items of interest. Each item will be 
highlighted.

Selecting Consecutive Items
To select several items in a row, use one of these methods:

Click on the first item, then hold the left mouse button as you drag the mouse to the last item of 
interest. Release the mouse button. 

Click the first item and press the Shift key while clicking on the last item.) All items in the block 
you've selected are highlighted.

For more information see:
Selecting Items to Add to a Map 
Finding Items on the Current Map 
Using the Map List Button 
Limiting Categories 
Performing a Search 
Working with Maps 



 Drawing Lines

You can draw straight lines or polylines (connected lines) to highlight portions of a map (to illustrate a 
journey or a boundary, for example). 

To draw a line on a map,

1. Activate the Toolbox (click the Toolbox icon on the icon bar or select Graphic Tools from the Edit 
menu).

2. Click on the desired line button at the top of the Toolbox. You can choose either the straight line or
the polyline.

3. Select the desired line color and width on the Toolbox. To choose a line color, select the Line 
option above the color palette, then click on the desired color. To select a line width, position the 
cursor on the correct width and click.

4. Move the cursor to the map and position it where you want the line to begin. Notice that when you
move the cursor onto the map, it changes to a crosshair cursor (+).

5. If you are drawing a straight line, click and hold the left mouse button as you drag the mouse 
across the map. An outline of the line appears as you drag the mouse to help you position the line
correctly. When you've finished drawing your line, release the mouse button. The line is drawn as 
indicated. 

If you are drawing a polyline, you do not have to hold down the mouse button as you're drawing the 
example. You can click once on the line's starting point, move the cursor to another position and click 
again, and move the cursor to yet another position and click again. An outline of the polyline you've drawn
appears on screen. When finished, double-click at the end of the line. The line is drawn as indicated.

For more information see:
Drawing Shapes 
Inserting Graphics into a Map 
Selecting Graphics 
Arranging Graphics 
Copying Graphics 
Moving Graphics 
Deleting Graphics 
Resizing Graphics 
Reusing graphics with the Add Graphics dialog box 



 Drawing Shapes

You can draw shapes on any map to identify or emphasize an area, for example. Drawing a shape is 
much like drawing a line. When you draw a shape, however, you can draw an outline of a shape or you 
can fill it to create a solid shape. 

To draw a shape on a map,

1. Activate the Toolbox (click the Toolbox icon on the icon bar or select Graphic Tools from the Edit 
menu of the Map window).

2. Click on the desired shape at the top of the Toolbox. You can choose a circle, square, arrowhead, 
or polygon. (See Arrowheads below for details on drawing arrowheads.)

3. Select the desired color and line width on the Toolbox. You can also select whether or not you 
want to fill the shape and specify a line color and a fill color.

To choose a line color, select the Line option above the color palette then click on the desired 
color. To select a fill color, select the Fill option above the color palette then click the desired color.
Click No Fill if you want the background to display behind the shape (so the shape doesn't cover 
up the map). To select the line width, position the cursor on the correct width and click.

4. Move the cursor to the map and position it where you want the shape to begin. Notice that when 
you move the cursor onto the map, it changes to a crosshair cursor (+).

5. Click and hold the left mouse button as you drag the mouse and "draw" the shape on the map. An
outline of the shape appears as you drag the mouse to help you position the shape correctly.

If you are drawing a polygon, you do not have to hold down the mouse button as you're drawing 
the shape. For example, you can click once at the shape's starting point, move the cursor to the 
next position and click again, etc. until you've defined all the anchor points for the shape you 
want. An outline of the shape you've drawn appears on screen.

6. When you've finished drawing your shape, release the mouse button. (If you're drawing a 
polygon, double click on the last anchor point to end the shape.) The shape is drawn as indicated.

Arrowheads
For information on drawing the arrowhead markers, click on Drawing Arrowheads.

For more information see:
Drawing Lines 
Inserting Graphics into a Map 
Selecting Graphics 
Arranging Graphics 
Copying Graphics 
Moving Graphics 
Deleting Graphics 
Resizing Graphics 
Reusing graphics with the Add Graphics dialog box 



 Selecting Graphics

Once you've created a line or shape, you may want to copy, delete, move, or resize it. To perform any of 
these options, you must first select the graphic. This produces graphic "handles" (small boxes) on the 
ends of lines and on various anchor points on a shape which can be used to manipulate the shape. These
handles only appear when the Toolbox is active; therefore, you cannot manipulate graphics when the 
Toolbox is disabled, such as with a Read Only installation.

To select a graphic from a Map window:

1. Activate the Toolbox (click the Toolbox icon on the icon bar or select Graphic Tools from the Edit 
menu).

2. Select the hand cursor or the arrow cursor (on the Toolbox or on the icon bar). 

If you are moving a graphic, select the hand cursor.

If you are resizing a graphic, select the arrow cursor. 

If you are copying or deleting a graphic, you can use either cursor.

3. Position the cursor on one of the graphic's handles and click. This selects the graphic. Note that 
the handles are a different color when the graphic is selected.

When you select a line or shape, the entire graphic is selected; therefore, you cannot delete or 
remove portions of a line or shape. If many shapes or lines have been used to illustrate a path or 
journey, for example, you can select each line or shape individually to delete them as needed.

NOTE: The graphic handles for circles do not appear on the circle as 
they do for lines and other shapes. The graphic handles for circles 
appear just outside the circle in the upper left and lower right corners of
the area the graphic encompasses.

For more information see:
Drawing Lines 
Drawing Shapes 
Inserting Graphics into a Map 
Copying Graphics 
Moving Graphics 
Deleting Graphics 
Resizing Graphics 
Reusing graphics with the Add Graphics dialog box 



 Copying Graphics

If you want to copy a line or shape you've already created, you can select it and copy it using special 
buttons on the Toolbox.

To copy a graphic,

1. Activate the Toolbox, if needed (click the Toolbox icon on the icon bar of the Map window or select
Graphic Tools from the Edit menu).

2. Select the desired graphic by clicking on one of the graphic's handles. For information on graphic 
handles and selecting graphics, click Selecting Graphics.

3. Click on the Copy button on the Toolbox. A duplicate appears next to the original graphic. You can
move the duplicate to another position if you like by selecting it and dragging it to the desired 
location; click Moving Graphics for details.

For more information see:
Drawing Lines 
Drawing Shapes 
Inserting Graphics into a Map 
Selecting Graphics 
Arranging Graphics 
Moving Graphics 
Deleting Graphics 
Resizing Graphics 
Reusing graphics with the Add Graphics dialog box 



 Moving Graphics

You can move or reposition any graphic on a map using the hand cursor.

To move a graphic:

1. Activate the Toolbox, if needed (click the Toolbox icon on the Map window's icon bar or select 
Graphic Tools from the Edit menu).

2. Click on the hand cursor on the Toolbox (or on the icon bar).

3. Select the desired graphic by clicking on one of the graphic's handles. For information on graphic 
handles and selecting graphics, click Selecting Graphics.

4. Click on one of the graphic's handles and hold the left mouse button as you drag the graphic to 
the desired location. Note that as you move the graphic, an outline of the line or shape follows to 
help you position the graphic correctly.

5. When you've positioned the graphic where you want it, release the mouse button. The graphic 
appears in the new location.

For more information see:
Drawing Lines 
Drawing Shapes 
Inserting Graphics into a Map 
Selecting Graphics 
Arranging Graphics 
Copying Graphics 
Deleting Graphics 
Resizing Graphics 
Reusing graphics with the Add Graphics dialog box 



 Deleting Graphics

The Toolbox allows you to delete any graphics you don't need.

To delete a graphic:

1. Activate the Toolbox, if needed (click the Toolbox icon on the Map window's icon bar or select 
Graphic Tools from the Edit menu).

2. Select the desired graphic by clicking on one of the graphic's handles. For information on graphic 
handles and selecting graphics, click Selecting Graphics.

3. Click on the Del button on the Toolbox. The graphic is removed from the map.

For more information see:
Drawing Lines 
Drawing Shapes 
Inserting Graphics into a Map 
Selecting Graphics 
Arranging Graphics 
Copying Graphics 
Moving Graphics 
Resizing Graphics 
Reusing graphics with the Add Graphics dialog box 



 Resizing Graphics

With the Toolbox active, you can use the arrow cursor to resize lines and shapes on a map.

To resize a graphic,

1. Activate the Toolbox, if needed (click the Toolbox icon on the Map window's icon bar or select 
Graphic Tools from the Edit menu).

2. Click on the arrow cursor on the Toolbox (or on the icon bar).

3. Position the cursor on one of the graphic's handles. For information on graphic handles and 
selecting graphics, click Selecting Graphics.

4. Click and hold the mouse button on the graphic handle and drag it to the desired position. When 
the line is the desired length or the shape is the desired size, release the mouse button. The 
object is resized accordingly.

For more information see:
Drawing Lines 
Drawing Shapes 
Inserting Graphics into a Map 
Selecting Graphics 
Arranging Graphics 
Copying Graphics 
Moving Graphics 
Deleting Graphics 
Reusing graphics with the Add Graphics dialog box 



 Reusing Graphics with the Add Graphics Dialog Box

The Toolbox allows you to add, save, and reuse graphics from other American History Explorer maps 
via the Add Graphics dialog.

Adding Graphics
To add a graphic:

1. Click the Add button shown at the bottom of the Toolbox.

2. In the Add Graphics dialog that appears (see below), select the item that you want to add to the 
map. Note that the Add Graphics dialog contains a list of states. This list can be used to place 
state boundary lines for one or more states on a map. Select and insert them as you would any 
other graphics.

3. Click the Add to Map button. The graphic will appear in the same position on the new map in the 
location where it was originally created.

4. Close the Add Graphics dialog by clicking the Close button.

Saving Graphics
To save a graphic from the Toolbox (so you can reuse it on another map):

1. Select the desired graphic.

2. Click the Add button at the bottom of the Toolbox.

3. Click the Save As button on the Add Graphics dialog and enter a name for the graphic in the Save
Graphic dialog that appears. Then click OK. The graphic name now appears in the Add Graphics 
dialog.

4. Close the Add Graphics dialog by clicking the Close button.

Deleting Graphics
You can also delete a graphic from the Add Graphics dialog by selecting it and clicking on the Del button 
on the Toolbox. Note that this deletes the graphic from your system, and it will no longer appear on the 
Add Graphics dialog.

For more information see:
Drawing Lines 
Drawing Shapes 
Inserting Graphics into a Map 
Selecting Graphics 
Arranging Graphics 
Copying Graphics 
Moving Graphics 
Deleting Graphics 
Resizing Graphics 



 Background Maps
A background map is an outline of a geographic region. Background maps may already contain graphic 
representations for rivers and land topography, but do not contain any map items (cities, names, events, 
etc.). 

Within American History Explorer background maps have been included to help you create your own 
maps. You can also use these backgrounds when changing the background for an existing map.

For more information, see:
Changing the Map Background 



 Copying Maps to the Windows Clipboard
You can copy a selected portion of a map to the Windows Clipboard to paste it into another Windows 
application, such as Paintbrush.

To copy a portion of a map to the Clipboard,

1. Select the area you want to copy using the right mouse button. (Click Selecting Parts of a Map for
details.)

2. Select Copy from the Edit menu of the Map window or click the Copy Map icon from the icon bar. 
The selected map area is copied to the Clipboard. For details on using the Clipboard, refer to 
your Windows manual.

For more information see:
Zooming Selected Areas on a Map 
Printing Maps 
Working with Maps 



 Creating Your Own Map Items

You can create your own items to add to a map instead of selecting from the list of available map items. 

When you create your own map item, you can select from a variety of options. You can display the name 
and a selected icon, a name only, or an icon only. You could use the Name and Icon selection to add 
cities and the name only option to add rivers or other geographical items, for example. You also can 
define the font characteristics for any names and the display attributes for any icons you add. You can 
attach a text article to a map item so that, once it's on the map, you can double-click on it to display 
additional information about that item on screen.

To add a user-defined item to a map:

1. Open the map and select Create New Item from the Edit menu. 

2. Note that when you move the cursor onto the map, it changes to a "Where?" indicator. Position 
this indicator where you want the new item to appear and click the left mouse button. The Edit 
Map Item dialog appears.

3. On the Edit Map Item dialog, you can enter the appropriate information. For details on the fields 
contained on this dialog, click Edit Map Item Dialog Box.

4. When you've finished entering information, click OK. The new map item appears on your map as 
defined.

For more information see:
Edit Map Item Dialog Box 
Selecting Items to Add to a Map 
Working with Map Items 
Working with Maps 



 Limiting Categories

You can limit the items that appear in the map item list by marking general categories of items to include 
in the box shown in the lower right corner of the dialog.

Map items are divided into categories: Cities, States, Regions, Events, Geo (geographical features), 
People, and Misc. Initially, all categories are selected.

To limit the categories,

1. Unmark (or mark) a category by clicking on the box preceding the desired option. 

2. Make all the selections that you want.

3. The map item list in the lower left corner of the dialog will change to display the items that match 
the categories you've marked. A category icon in front of each item indicates its category (for 
example, a skyline denotes a city).

For more information see:
Selecting Items from the Map Item List 
Selecting Items to Add to a Map 
Finding an Item on the Current Map 
Using the Map List Button 
Performing a Search 
Working with Maps 



 The Map List Button

At some time you may wish to locate a map that has a specific item. For example, you may wish to find 
maps that include the Alamo. The Map List button in the Place/Names dialog box will help you locate all 
the relevant maps.

To view a list of maps where a specific item is displayed:

1. Click the Search icon or select Find/Select Items from the Search menu of any Map window. This 
opens the Place/Names dialog box.

2. Select the item from the list in the Place/Names dialog box.

3. Click on the Map List button. A Select Map dialog appears listing all of the maps that include the 
item you've selected.

4. Highlight a map and click OK to open it.

Selecting Untitled Maps
The Select Map dialog list (see step 3 above) also contains an ***Untitled Map*** option you can use to 
open a new map (based on one of the backgrounds) with the selected item appropriately placed on the 
map. Simply highlight this option and click OK. Other map items can be added to the untitled map by 
selecting items from the map item list and clicking the Add button. 

If you use the Map List button again to locate another item and choose ***Untitled Map***, the next item 
will be added to a new untitled map, after prompting you to save the previous untitled map. 

For more information see:
Limiting Categories 
Selecting Items from the Map Item List 
Finding an Item on the Current Map 
Performing a Search 
Working with Maps 



 Article Window
Whenever you open a new or existing article in American History Explorer, the article appears inside an
Article window. 

You can change the size and location of the window like any other window within a Microsoft Windows 
application. (For example, just point to any corner or border, and when the cursor changes to a two-
headed arrow, drag the corner or border until the window is the size you want. You can also click on the 
title bar and hold down the mouse button to drag the entire window to another position on the screen.)

You can also open more than one window at a time. For example, you can open an Article window while 
you have a Map window open. (You can NOT open more than one Article window at a time). 

Below is an illustration of an Article window. Click on any portion of it for additional information.

To close an article (which closes the Article window, too), do any of the following:

Select Close from the Article menu.

Click on the Close Article icon on the icon bar.

Double-click on the Control-menu box in the upper left corner of the Article window.

For more information see:
Screen Elements 
Menu Bar 
Icon Bar 
Scroll Bars 



 Displaying Legends

To display a legend for a map, open the desired map and click on the Legend icon (or select Display 
Legend from the Options menu). The appropriate map legend appears within the Map window. 

You can move the legend anywhere on the map to improve your map view. Just click on the title bar of the
legend and drag the legend to a new location.

If you scroll through the map so that its legend is no longer visible, choose the Display Legend option. 
When you choose it once more, it will reposition the legend in the lower right corner of the Map window.

You can edit a legend for an existing map or any maps you've created (if you used the Read/Write 
installation option). To make changes, select Edit Legend from the Edit menu to open the Map Legend 
dialog box. 

To close a legend, double-click on the Control-menu box icon in the upper left corner of the legend 
window or click the Legend icon on the icon bar.

For more information, see:
Editing Legends 
Map Legend Dialog Box 



Map Windows
Map windows are screens used to display American History Explorer maps. A Map window offers 
several menu options and an icon bar for modifying and manipulating the maps. The status bar at the 
bottom of a Map window is also used to display relevant information. These    features are explained in the
Help topic Map Window.



 Operating the Finder

American History Explorer provides a "Finder" feature from the Opening Screen to help you locate 
specific information in the program. For example, if you want to know about Daniel Boone, you can 
quickly locate information --from an article, picture, map, video, or slide show.

To open the Finder and locate information,

1. Click the Finder icon (bookcase) on the Opening Screen to open a Search dialog box, as 
illustrated below. (Some data has been entered in the sample.)

2. In the Query field at the top of the dialog, enter a word or phrase such as the name of the person,
place, or event that you want to research.

3. Select other options to limit your search. (Click on Search Dialog Box for details.)

4. When you're satisfied with the settings, click the Find button. The program will search through all 
the categories you've selected and present a Search Results box with its findings. This may take 
some time, depending on the Settings of your search and your computer. A status dialog tracks 
the status of your search.

5. Select any item in the Search Results box and click View to instantly access the item.

For more information, see:
Opening Maps 
Viewing Articles 
Finding Map Items 



 Hall of Presidents

The Hall of Presidents feature gives you details on the lives of America's first presidents. You can read 
their inaugural addresses, view slide shows about them, and learn about their lives -- everything from 
their religious preferences, how old they were when they married, how many children they had, and what 
caused their deaths.

For more information, see:
Opening the Hall of Presidents 
Studying a President
Comparing Presidents 
Tips on Scrolling 



Article Windows 
Article windows are screens that display an article. At the top of an Article window is a menu bar (if you 
used the Read/Write installation option) and an icon bar. Both can be used to work with articles. Click on 
Screen Elements for more information.



Menu Bars
Menu bars, displayed across the top of Map windows and Article windows, give you access to program 
features. These menu bars are only displayed if you use the Read/Write installation option. For details, 
click Menu Bar.



Links
Links are ties between text in one article and another article or a picture. Article links are marked by text 

of a different color. Picture links are marked by an icon ( ).

Clicking on a link allows you to jump from an open article to either a related picture or a different article 
that contains related information.



Icon Bar
An icon bar is a row of buttons with icons (pictures or symbols). In American History Explorer, icon bars 
appear in Map windows and Article windows. If you have selected the Read/Write installation option, the 
icon bar will appear below the menu bar; otherwise they will appear below the title bar. You can click on 
an icon bar button, rather than select from a menu, to access a program feature. For details on the icon 
bars, click on Icon Bar.



 Adjusting Program Volume

American History Explorer has no separate volume controls for monitoring the sound on slide shows, 
movies, songs, and the Hall of Presidents. To adjust the program volume, you'll need to use your system 
controls.

To adjust your system volume,

First check any external manual controls. For example, many systems have volume control knobs
on the speakers.

If there is no volume control on your speaker, check the guide provided with your sound system. 
Often there is a mixer panel that allows you to adjust the volume for all applications.

For more information, see:
Exiting Videos 
Operating Slide Show Controls
Operating the Song Book 
Exiting the Hall of Presidents 



 Opening the Hall of Presidents

To open the Hall of Presidents and learn more about any of the presidents, 

1. Click on the Hall of Presidents icon on the Opening Screen. A gallery of presidential portraits 
appears.

2. Click the portrait of any president. A brief description of the president is announced.

From here you can go on to more detail about the selected president by clicking the portrait or 
nameplate. Click on Studying a President for details.

You can also scroll left and right to hear brief descriptions of the other presidents. 

3. To hear about other presidents, move the pointer cursor to either side of the screen. The pointer 
will turn into a solid arrow cursor. Click and hold the left mouse button as you bump the edge of 
the screen to scroll right or left.

When the next president's portrait is centered on the screen, the program will read a brief 
description about him.

At any time you can click on a president's portrait or nameplate to access more details about him.

4. To return to the gallery of presidential portraits, click on the shelved book icon.

For more information, see:
Exiting the Hall of Presidents 
Working with Articles 
Working with Maps 



 Comparing Presidents

Comparing Presidents is a feature of the Hall of Presidents that allows you to view side-by-side the details
of the country's presidents through 1872 (including Jefferson Davis, President of the Confederacy during 
the Civil War).

To open the presidential comparison,

1. Click on the Hall of Presidents icon on the Opening Screen. The gallery of presidential portraits 
opens.

2. Click on the portrait of any president. A brief description of the president is read for you.

3. Click on the president's nameplate or portrait to access more options. 

4. Click the Compare Presidents icon. A table is displayed on screen.

To use the comparison table,

Scroll across the table to read a row of details about one particular president or compare him to 
other presidents by column.
(For instructions on scrolling left and right, click on Tips on Scrolling). 

At any time you can access the details about a single president. To do so,

1. Move your cursor to the list of presidents on the left side of the screen.

2. When the pointer cursor changes to a hand cursor, click on a president's name. You'll be returned
to the president's portrait where you can hear a brief description of his life. For more information, 
click the president's nameplate or his portrait. (Click on Opening the Hall of Presidents, for more 
information.)

To close the comparison grid,

1. Click on the curled page at the bottom of the list of presidents. This returns you to the previous 
screen. 

For more information, see:
Studying a President 
Basic Information 



Overview Article
An article associated with a map that supplies general information about the data depicted on the map. An
Overview article can be accessed by clicking the Overview Article icon (a hot-air balloon) on the icon bar 
of the Map window or by selecting Overview Article from the Articles menu.



People Article
An article associated with a map that provides a biographical sketch of a person related to the events 
depicted on the map, or a list of linked articles, if there's more than one person. A People article can be 
accessed by clicking the People Article icon on the icon bar of the Map window or by selecting People 
Article from the Articles menu.



Document Article
An article associated with a map that provides the text of a historic document related to the events 
depicted on the map, or a list of linked articles, if there's more than one document. A Document article can
be accessed by clicking the Document Article icon from the icon bar of the Map window or selecting 
Document Article from the Articles menu.



 Time Line Year Articles

When you open a time line, the main time line that runs through the middle of your screen is marked with 
the years covered by that time line. Each of these four-digit dates (1775, for example) functions like an 
article icon. Just click on the date to open a Year article. A Year article lists and links to all the articles that 
fall within the selected year.

For example, if you want to study what was happening in America in 1865, 

1. Open the Civil War time line and locate the 1865 marker on the main time line.

2. Click on the year. The program opens the 1865 article, listing all the articles that mention the year 
1865. 

3. Select any article of interest and click on it to open it.

When you're finished studying that item, select Back from the Links menu (or click the Previous Linked 
Article icon) to return to the 1865 Year article and select another article.

When you're through with the Year article, close it the way you would any other article. (For details, click 
on Closing Screens.)

For more information, see:
Accessing Items from a Time Line    
Working with Articles 
Exiting Time Lines 
Working with Maps 



 Search Dialog Box

When you click the Finder icon on the Opening Screen, a Search dialog box appears where you can 
define the items that you want the program to locate for you. 

To conduct the search.

1. In the Query field at the top of the dialog, enter a word or phrase such as the name of the person,
place, or event that you want to research.

At this point, you can begin the search process. However, the Search dialog offers you several 
options to further define what information you're seeking. This will speed the search process and 
reduce the number of items from which you have to choose. If you want to refine the search, 
complete the following areas in the dialog box BEFORE clicking the Find button.

Categories
In the Categories box, mark the categories that are appropriate for your search. (For example, if 
you only want a map, just mark that option.) Categories can be marked and unmarked by clicking 
on the category name. 

Search Limits
In the Search Limits box, indicate whether you want the program to search for your word or 
phrase only in titles, or throughout all the text included in the program. (This includes text in a 
slide show or video.) 

To further refine the search, you can check the option to do a Title Search by First Word only.

For example, if your enter the word Thomas and mark the First Word option, the Finder will locate
the article on Thomas, George, a Union general during the Civil War. However, if you leave the 
First Word option blank, the program will have to search through all the words in all the titles, and 
may come up with more articles containing the word Thomas in the title, such as Edison, Thomas,
as well as the article on Thomas, George.

Match 
In the Match box, mark whether you want the program to search for Words or Partial Words. This 
is handy if you're not sure of the spelling of a term or name. For example, entering John in the 
Query field and selecting Partial Words will locate all references to John, Johnny, Johnson, 
Johnston, and Johnstone. Had you selected Words, the program would only locate references to 
John. 

2. When you're satisfied with the settings, click the Find button. 

(If you plan to do several searches, you may wish to click the Save Search Settings box at the 
bottom of the dialog. With the box checked, the next time you open the Finder, your choices for 
the Categories, Search Limits, and Match areas will be marked.)

The program will search through all the categories you've selected and present a Search Results 
dialog box with its findings. (Click on Operating the Finder for more information.)

NOTE:    At any time, you can click Cancel on the Search dialog to 
return to your original place in the program. A Search Results dialog will
display its findings up until that point.



For more information, see:
Opening Maps 
Viewing Articles 
Finding Map Items 



 Select Picture Dialog Box

When you click the Picture Album from the Opening Screen, a Select Picture dialog appears where you 
can choose a picture to view.

You can use the scroll bars (or the up and down arrow keys on your keyboard) to scroll through the list of 
title of available pictures. To select a picture on the dialog, do one of the following:

Click on the desired picture title with your mouse.

Use the up and down arrow keys.

Type the first few letters of the picture's name into the input field above the list.
After you've selected the desired picture, click OK. The selected picture opens in its own window. (You 
can also double click on a picture on the Select Picture dialog box to select it and open it in one step. In 
this case, you do not need to click the OK button.) 

NOTE:    At any time, you can click Cancel on the Select Background 
dialog to return to your original place in the program.

For more information see:
Viewing 3D Images 



 Exiting the Hall of Presidents

To exit the Hall of Presidents, click the curl at the bottom, right-hand corner of the screen. You may have 
to click more than one curl to return to the Opening Screen.

If you're in the Compare Presidents segment, the curl is located at the bottom of the presidents' names -- 
the far left column.

For more information, see:
Closing Screens 



Control-Menu Box
This button in the upper left corner of most windows, lets you move, resize, and close the window.



Title Bar
This bar, across the top of most windows and dialog boxes, displays the name of the window. Usually, you
can click and hold the left mouse button on the title bar to drag the window to a different location on the 
desktop.



Minimize Button - Definition
This button in the upper right corner of most windows (just left of the maximize button) can be used to 
reduce the window to an icon on your desktop. Just click on the button to reduce the window without 
closing it. 



Maximize/Restore Button - Definition
This button in the upper right corner of most windows (just right of the minimize button) can be used to 
enlarge the window to fill the entire desktop. Just click on the button to fill the screen. After you enlarge a 
window using the maximize button, the button is replaced by a Restore button. Click on the Restore 

button ( ) to return the window to its previous size.



Legend
This box, which may appear on a Map window, provides additional information about the map and items 
displayed on it. If you prefer to hide a map legend, select Display Legend from the Options menu of the 
Map window. If this option is checked the legend will appear. Select it again to remove the check mark 
and hide the legend. You can also click the Legend icon to display or hide the legend. For more 
information, click on Legends.



Scroll Bars
A horizontal bar displayed at the bottom and a vertical bar displayed on the right edge of a window whose 
contents cannot be entirely viewed on screen. 

You can use the arrow buttons to move one line at a time or click and hold an arrow button to scroll 
continuously. You can also click and drag the box on the scroll bar to move to another location within the 
window. Click above or below the box on the scroll bar to jump about one screen.

For more information, click on Scroll Bars or Tips on Scrolling.



Status Bar
This bar along the bottom of a Map window, displays important information as you work with maps. It 
includes:

A help segment on the left with hints for operating the program.

A distance meter in the center that displays the distance between two or more points when you 
use the distance measurement feature. 

A latitude/longitude indicator on the right that displays the location of a selected map item, such 
as a city. 
For more information, click on Status Bar.



Map Item
This is an item either provided with the program or created by the user to further explain the map. Map 
items, such as rivers, cities, regions, battles, and events can be marked with just a name, just an icon, or 
both. For more information, click on Working with Map Items.



Rewind
Rewinds the slide show. Click and hold the mouse button to rewind to the beginning of the slide show or 
click and release the mouse to rewind one slide at a time. You can also restart the slide show by closing 
the slide show, selecting the Slide Shows icon from the Opening Screen, and selecting the slide show 
again.



Stop
Stops or pauses the slide show. Use this option if you want to examine a slide more closely. When you're 
done, click the Play button to continue the slide show or click the Rewind button to review what you've 
just heard.



Fast Forward
Advances the slides quickly. You will not be able to hear the narration with this option. When you reach 
the point you wish to listen to, click the Stop button, then click the Play button.



Play 
Starts the slide show, with narration, after you have clicked the Rewind, Stop, or Fast Forward buttons.



Linked Article
This text, displayed in a different color than other text, indicates that there is a related article "linked" to 
the current article. You can click on the colored text to jump directly to the linked article. The linked article 
is usually about the subject highlighted by the colored text. You can also add your own links. For more 
information, click on Linking Text to an Article.



Linked Picture

This icon indicates a picture link. Picture links are included in many of the program's articles. You 
can click on the icon to jump directly to the linked picture. The linked picture usually relates to the subject 
of the text in front of the icon. When you're done viewing a picture, you can close it and return to the 
article by double-clicking the Control-menu box icon in the top left corner of the Picture window.



 Studying a President

To access information about any U.S. president who served through 1870, 

1. Click on the Hall of Presidents icon on the Opening Screen. A gallery of presidential portraits 
appears.

2. Click the portrait of the president that you want to study. A brief description of the president is read
for you.

3. Click on the president's name plate or portrait to access other information. You can choose to:

Learn about the Election.    Click this option to open a map that displays the results of the 
applicable presidential election. From the map you can access the Overview Article to read more 
about the election, the People Article to read about others who played significant roles in the 
election, and the Document Article to read the selected president's inaugural address.

Read about the Man.    Click this option to read a three-part summary of information about the 
selected president. The article includes sections on His Profile (lists of the president's family, 
background, physical characteristics, occupation, last words, etc.) His Milestones (lists of military
and government achievements), and His Story (detailed history of his life and accomplishments).

NOTE:    This article can be edited, just like any other article, so you can
add additional information to it. Click on Editing Articles for instructions.

View a Slide Show.    Click this option to view and listen to a slide show about the president.

Compare Presidents.    Click this option to compare the selected president with other presidents 
of early America. For details on using this feature, click Comparing Presidents 

For more information, see:
Exiting the Hall of Presidents 
Working with Articles 
Working with Maps 



 Viewing 3D Images with Glasses

The stereo images in the 3D Gallery will come alive with the viewing glasses (viewer) provided with 
American History Explorer. Tips for positioning the stereo viewer are offered below, followed by 
instructions for viewing the images.

Tips for Positioning the Stereo Viewer

Place the viewer on the bridge of your nose.

If you wear eyeglasses, hold the viewer in front of your glasses.

Experiment with the viewer to find your comfort level.

Tilt the viewer back and forth or rock it up and down slightly as you're viewing the stereo images.

Viewing Stereo Images
Once you've positioned the viewer, click on the 3D Gallery and select the image you wish to view. Then 
follow the steps below.

1. Position yourself so the stereo image on your monitor is centered in front of your nose.

2. Moving your face toward the monitor, close one eye and move your head forward and backward 
to find your best focal point.

3. Open both eyes and the stereo image should merge and come alive!

If you aren't able to see a fused image, try moving the viewer back and forth on your nose, tilt it 
back and forth or rock it up and down slightly until the fusion is accomplished. 

NOTE:    For a good 3D "practice" image, refer to Page 9 of your 
Information Guide.

For instructions on viewing a stereo image without the special viewer, click on Free Viewing.



 Free Viewing 3D Images

In addition to viewing the 3D Images with a viewer, you can also "free view the images without the viewer.
Free viewing is a learned skill -- you teach your brain to see what you want it to see.

Before attempting this with the computer images, following the steps below for a practice session.

1. Look at the illustration on page 9 in your Information Guide to determine a normal comfortable 
reading distance. (Because of differing visions, this distance will vary with everyone). Remember 
that distance.

2. Looking out a window, stare at an object (tree or house) about 100 yards away. Relax. Pay 
attention to how your eyes feel as they are staring at the object. 

3. With your eyes fixed on the object, slowly bring the illustration into your field of vision at your 
correct reading distance, with your nose aligned with the center of the image. You should be 
viewing the image as though you were looking through the page, not at the page. The image will 
be out of focus, but concentrate on relaxing your eyes.

4. Draw your attention to the two dots at the top of the illustration. If you're still on track, you will 
actually see three dots. Concentrate on the middle dot with your mind -- not your eyes! You will 
see the right and left dot in your peripheral vision, but focus (not with your eyes) on the center 
dot.

5. Now, shift your attention to the alphabet letters without losing your focus. 

You may not be successful on the first try, but don't give up. Practice again. Soon you'll be able to 
eliminate steps 1 and 2 and view any stereo image. When you apply this method to viewing 
stereo on your monitor, the viewing distance will be greater than with your viewer glasses. 

For more information, see:
Viewing 3D Images with Glasses 



Close Box
Double-click this box to close the Toolbox.



Toolbox Title Bar
This title bar functions as other full-size title bars. Use it to drag the Toolbox to a different location.



Toolbox Pointer Cursor
This cursor is used to draw lines and shapes, select graphics, and resize graphics. For details, click on 
Drawing Lines, Drawing Shapes,, Selecting Graphics, or Resizing Graphics.



Toolbox Hand Cursor
This cursor is used to select and move graphics. For details, click on Selecting Graphics, or Moving 
Graphics.



Circle Tool
This tool is used to draw circles and ovals. For details, click on Drawing Shapes.



Line Tool
This tool is used to draw straight lines. For details, click on Drawing Lines.



Polyline Tool
This tool is used to draw connected lines. For details, click on Drawing Lines.



Polygon Tool
This tool is used to draw irregular shapes. For details, click on Drawing Shapes.



Square Tool
This tool is used to draw squares and rectangles. For details, click on Drawing Shapes.



Arrowhead Tool
This tool is used to draw triangle-shaped arrowheads. They can be used to mark the direction of trails or 
just as individual markers. For details, click on Drawing Arrowheads.



Arrowhead Orientation Tool
This tool is used to point the arrowhead tool in a specific direction. For details, click on Drawing 
Arrowheads.



Toolbox Top Button
This tool is used to rearrange overlapping graphics. The graphic selected when you click this button will 
be placed on top of any overlapping graphic.



Toolbox Copy Button
Click this button to copy the selected graphic to the Windows Clipboard. For details, click on Copying 
Graphics.



Toolbox Delete Button
Click this button to delete the selected graphic. For details, click on Deleting Graphics.



Toolbox Line Button
Click this button, then click a color button to select a color for your lines. 



Toolbox Fill Button
Click this button, then click a color button or a pattern button to select a background for your shapes.



Toolbox Colors
Click one of these buttons to select a color for lines or shapes. 



Toolbox Patterns
Click one of these buttons to select a fill pattern for shapes. 



No Fill Button
Click this button to select a clear (see-through) background for shapes. This allows you to place a circle 
or box on the map, yet still see the map items under the box.



Toolbox Line Widths
Click one of these buttons to select the thickness of your lines. 



Toolbox Add Button
Click this button to add a graphic to a map. For instructions, click on Reusing Graphics. 



 Drawing Arrowheads

You can use the arrowhead shape on the Toolbox to draw arrowheads for lines on a map (to illustrate a 
journey in a particular direction, for example). However, you should note that drawing an arrowhead is 
slightly different than drawing other shapes. 

To draw an arrowhead, follow these steps:

1. With the arrowhead shape selected, click on the arrowhead orientation buttons to the right of the 
arrowhead button to choose the desired direction for the arrowhead. 

You can also select the line width, line color, and fill color for the arrowhead using special buttons 
on the Toolbox. To select the line width, position the cursor on the correct width and click. To 
choose a line color, select the Line option above the color palette then click on the desired color. 
To select a fill color, select the Fill option above the color palette then click the desired color. Click
No Fill if you want the background to display behind the shape.

2. Position the cursor where you want the arrowhead to appear. Note that when you move the 
cursor onto the map, it changes to an arrowhead indicator. This will help you position the 
arrowhead correctly on the map.

3. When you've placed the cursor where you want the arrowhead to appear, click once with your 
mouse. The shape appears on your map where indicated.

Once you've placed an arrowhead on a map, you can copy, move, delete, and resize it as you 
would any other shape.

For more information see:
Drawing Shapes 
Drawing Lines 
Inserting Graphics into a Map 
Selecting Graphics 
Arranging Graphics 
Copying Graphics 
Moving Graphics 
Deleting Graphics 
Resizing Graphics 
Reusing graphics with the Add Graphics dialog box 



 Map Window Icon Bar

The Map window icon bar is located at the top of the window (or, if you installed the Read/Write version of
the program, just below the menu bar.). 

You can click on the icon buttons, instead of selecting menu options, to access frequently used American
History Explorer features. For example, if you have a Map window open, you can open the Select Map 
dialog box by clicking the left button on the icon bar rather than choosing Open from the Map menu. 

Below is an illustration of    the Map window icon bar. Click on any of the buttons for a description of its 
operation.

NOTE:    If you use the Read Only installation option, you will NOT have 
access to the following icons:    
Arrow Cursor, Hand Cursor, Edit Map Item, Edit or Create Map Graphics.

For more information, see:
Article Window Icon Bar 
Menus 
Installation Options    
Screen Elements 
Menu Bar 
Map Item list 
Map window 
Legend 
Articles 
Scroll Bars 
Status Bar 
Toolbox 
Minimize Button 
Maximize Button 



 Article Window Icon Bar

The Article window icon bar. is located at the top of the window (or, if you installed the Read/Write version 
of the program, just below the menu bar.). 

You can click on the icon buttons, instead of selecting menu options, to access frequently used American
History Explorer features. For example, if you have an Article window open, you can open the Select 
Article dialog box by clicking the left button on the icon bar rather than choosing Open from the Article 
menu. 

Below is an illustration of    the Article window icon bar. Click on any button for a description of its 
operation.

For more information see:
Map Window Icon Bar 
Menus 
Installation Options    
Screen Elements 
Menu Bar 
Map Item list 
Map window 
Legend 
Articles 
Scroll Bars 
Status Bar 
Toolbox 
Minimize Button 
Maximize Button 



 Settings Dialog Box

Many of the optional settings for the American History Explorer are available in the Settings dialog box. 
From this box you can set the scrolling speed of maps, distance units on maps, and the color of article 
links. 

To modify program settings,

1. Click anywhere on the words American History Explorer on the Opening Screen to open the 
"About" box. (This animated screen displays acknowledgments to the team that developed the 
program. )

2. Click the Settings button at the bottom of the About box to open the Settings dialog.

3. Select the feature you wish to modify and mark your choice as explained below.

Distance Units -- Specify whether you want the program to display distances between points on 
a map in miles or kilometers. (Distance is displayed on the status bar at the bottom of a Map 
window.)

Text Hotlink Color -- Specify the color for words in an article that are linked to other articles.

Scrolling Speed -- Specify how fast you want to be able to scroll through maps. You can enter 
any number from 1 to 10. Lower numbers allow you to scroll line by line, whereas higher numbers
scroll several lines at a time.

NOTE:    Depending on the type of computer you have, very low 
numbers may make the program appear to run slowly. To scroll more 
quickly, you can increase the number of scroll units to find a speed that
is comfortable for you.

Display Opening Video--American History Explorer will play introductory music and a brief 
video every time the program starts, if this check box is marked. Click on the check box to 
remove (or replace) the X.

Display Program Tour--American History Explorer will present an overview of American 
history and display a quick tour of the program features every time the program starts, if this 
check box is marked. Click on the check box to remove (or replace) the X.

Display Warning When Exiting Program--American History Explorer will display a warning 
every time you attempt to exit the program, if this check box is marked. Click on the check box to 
remove (or replace) the X.

4. When you're finished making choices, click OK to close the dialog and save your settings.

For more information, see:
Fonts 
Displaying Legends 
Zooming In and Out on Maps 



 Moving Text to Word Processors

If you wish, you can move text from American History Explorer articles to a word processor, making it 
easier for you to add to and edit the information. This may be helpful, for example, if you are writing a 
report or making an outline.

To move the text of an entire article to a word processing application,

1. Open the article containing text you wish to use. (Click on Viewing Articles if you want step by 
step instructions.)

2. Choose Select All from the Edit menu to highlight all the text in the article.

3. Click the Copy Article icon on the icon bar (or choose Select All from the Edit menu then pick 
Copy from the Edit menu). This places the text on the Windows Clipboard.

4. Open your word processing application (such as Word for Windows). If your word processor is 
already running, switch to it. (You can switch between Windows applications by holding down the 
Alt key on your keyboard and pressing the Tab key until you access the program you want.) 

Note: It is not necessary to close American History Explorer before switching to your word 
processor.

5. In the word processing program, open the new or existing document where you plan to insert the 
text from American History Explorer. 

6. Move your cursor to the point where you want to place the text and select Paste from the Edit 
menu of your word processor. (Refer to the user's guide for your word processor, if necessary.) 
The text from American History Explorer will be inserted into your document.

To move only a portion of text from an article to a word processor,

1. Open the article containing the text you wish to use. (Click on Viewing Articles if you want step by 
step instructions.)

2. Hold down the mouse button as you drag your cursor over the text you wish to move. The 
selected text will be highlighted.

3. Select Copy from the Edit menu to copy the text to the Windows Clipboard.

4. Follow steps 4, 5, and 6 in the section above to open your word processor and paste the text in 
your document.

For more information see:
Editing Articles    
Working with Articles 



 Changing Link Color

Many of the articles in American History Explorer contain links to other articles. The text for these links 
appears in a different color than the rest of the article. If you wish, you can change this link color for all 
articles.

To set the link color,

1. Select the About... option on the Help menu of any Article or Map window to open the "About" 
box. You can also open the box by clicking anywhere on the words American History Explorer 
on the Opening Screen. (This animated screen displays acknowledgments to the team that 
developed the program. ) 

2. Click the Settings button at the bottom of the About box to open the Settings dialog.

3. Under the Text hotlink color option, click on your choice of the colors displayed. (You may need to
scroll to see all your choices.)

4. Click OK to close the dialog and save your settings. 

You can change the link color whenever you wish. It will apply to all article links until you change it again.

See also:
Fonts 



 About the Musicians

Songs in the American History Explorer Song Book are performed by Bobby Horton and Linda Russell. 
For more about each of these artists and the songs included in the program, select one of the topics 
below.

Bobby Horton 
Civil War Songs 
Linda Russell 
Colonial Songs 



 Bobby Horton
Bobby Horton combines his musical talent with original lyrics of Civil War tunes to express history in a 
form you probably won't find in history books. Based on extensive, historic research, his music comes 
alive with the emotions of Civil War soldiers, their families, and the battles won and lost. 

Realizing that music was an escape from the horrors of the bloody war and a source of hope, Bobby 
selected tunes written by those who lived through the war. He purposefully blends the music and lyrics to 
develop empathy for the feelings of men and women in both the South and the North.

Bobby's musical credits include contributions to two epic public television series: the Civil War and 
Baseball. In these recordings, Bobby plays all the instruments, sings all the parts, and records everything 
in his home in Birmingham, Alabama.

For more information, call    (205) 967-6426 or write to 3430 Sagebrook Lane, Birmingham, AL, 35243. 

All Civil War musical selections in American History Explorer were chosen from these Bobby Horton 
recordings:

Homespun Songs of the C.S.A., Volume 1

Homespun Songs of the C.S.A., Volume 2

Homespun Songs of the C.S.A., Volume 4

Homespun Songs of the Union Army, Volume 1

Homespun Songs of the Union Army, Volume 2

Homespun Songs of the Union Army, Volume 3

For details on the songs, including the composers and lyricists, click on Civil War Songs.

For more information, see:
Linda Russell 
Colonial Songs 



 Linda Russell

Linda Russell's gift is creating musical portraits of specific eras or individuals in American history. 

She illuminates these portraits with ballads, dance tunes, and broadsides. Bringing musical life to 
America's past, she also writes her own original songs.

Linda has been a balladeer for the National Park Service at Federal Hall National Memorial in New York 
City. She also has performed for radio broadcasts and at historical sites. She plays guitar, mountain and 
hammered dulcimers, penny whistle, and limberjack. 

For more information, call (212) 666-2656 or write to: 250 W. 99th Street, Apt. 8C, New York, NY 10025.

The Colonial musical selections in American History Explorer were chosen from these Linda Russell 
recordings:

Roses of the Garden

The Good Old Colony Days
For details on the songs, including the composers and lyricists, click on Colonial Songs.

For more information, see:
Bobby Horton 
Civil War Songs 



 Civil War Songs

Following are descriptions of Civil War songs performed by Bobby Horton and included in the American 
History Explorer Song Book.

Everybody's Dixie - General Albert Pike of Arkansas wrote these fighting lyrics to Daniel 
Emmett's popular melody. Presented here are three of General Pike's seven verses. (Banjo, Guitar, 
Mandolin, Fiddle and Vocal)

Maryland, My Maryland - James Ryder Randall wrote this poem in 1861. It was sung extensively
in the early war period, but its popularity waned after the unsuccessful invasion of Maryland by General 
Lee's army in September of 1862. (Guitar, Trumpets and Vocals)

Rose of Alabama - This 1855 minstrel tune was very popular in the 19th century. (Banjo, 
Mandolin, Fiddle, Guitar, and Vocals)

Stonewall Jackson's Way - This tribute to Stonewall Jackson and his men was written by John 
W. Palmer. The second part of the presentation is a simulation of Confederate musicians marching by. 
(Fifes, Drums and Vocals)

The Bonnie Blue Flag - Every soldier who wore the gray knew and loved this song. Harry W. 
MacCarthy wrote these lyrics to the old Irish melody, The Irish Jaunting Car. It was popular from the 
beginning to the end of the Southern Confederacy. (Trumpet, Drums, Guitar, Fifes, and Vocal)

Oh, I'm a Good Old Rebel - Many Southerners were quite bitter after the fall of the Confederacy, 
the devastation of the country, and the nightmare of the Reconstruction period. One such bitter veteran, 
Innes Randolph, revealed his true feelings in this tune. The melody is the old melody Joe Bowers - an 
Irish tune. (Guitar, Fiddles and Vocal)

Wait for the Wagon - This popular 1850's minstrel melody was composed by R.P. Buckley; the 
lyrics presented here were made-up in the infancy of the Confederacy by unknown authors. (Guitar, 
Trumpet, Drums, Banjo, Mandolin, Vocals)

Jine the Cavalry - J.E.B. Stuart by reputation was the singing-est Confederate of them all. He 
carried a banjo player, Sam Sweeney (whose brother, Joel, invented the five-string banjo in 1831), and 
Mulatto Bob (Fiddle and bones) everywhere he went. Music was always found in his camps. This is 
J.E.B.'s theme song. (Banjo, Fiddlesticks, Mandolin, Vocals)

The Battle of Shiloh Hill - This one of the truly great songs of the war! M.B. Smith, a member of 
the 2nd Texas Volunteer Infantry, wrote these powerful lyrics to describe the horrors he witnessed at the 
two day Battle of Shiloh (April 1, 1862). The melody is The Wandering Sailor. (Fiddle, Penny Whistle, 
Harp and Vocals)

Battle Cry of Freedom - This very important tune was one of George Roof's many compositions.
Picture if you will: A soldier begins playing his banjo and singing Battle Cry, and one by one, other boys 
join in for a rousing finish. (Banjo, Sticks, Mandolin, Fiddle, Whistle, Drums and Vocals)

Weeping Sad and Lonely - This song by Charles Carroll Sawyer may have been the most 
popular song of the period. It touched Yankee and Rebel alike as the war slowed and casualties mounted.
The desire for peace had to be expressed -- this tune was the perfect vehicle. (Guitar, Mandolin and 



Vocals)

The Battle Hymn of the Republic - Julia Ward Howe penned these words which became the 
most popular Union fight song. All military bands played it and most all soldiers knew the words. The 
setting for this arrangement is in camp -- one private begins on the banjo and is joined along the way by 
other fellows. (Banjo, Mandolin, Fiddle, Guitar, Drums, Penny Whistle and Vocals)

When Johnny Comes Marching Home - Patrick S. Gilmore was the band master of all Union 
armies when he wrote this tune. It is and has been a well known and popular tune which has come to 
symbolize the return of Americans from war. (Guitar, Fiddles, Bouzouki and Vocals)

Tramp, Tramp, Tramp - This George Root tune gave hope of eventual freedom to P.O.W.s and 
their families at home -- in fact, this song is subtitled The Prisoners' Hope. This may have been Mr. Root's
bigger tune. (Cornets, Baritones, Tuba, Drum and Vocals)

For more information, see:
Linda Russell    
Colonial Songs 
Bobby Horton 



 Colonial Songs

Following are descriptions of Colonial period songs performed by Linda Russell and included in the 
American History Explorer Song Book.

The Meeting of the Waters (traditional) - The original name for this old Irish tune was The Old 
Head of Dennis. Thomas Moore wrote new words for the music in 1807.

The Golden Vanity (broadside) - Traces its origins to the days of the Spanish Armada. This news
song has remained popular for four hundred years. Music had functions beyond entertainment. It served 
as an important mode of communication. Broadsides were topical songs containing anything from the 
latest news story to political ideas and propaganda. They were sold in the streets for two pennies a sheet.
The author would simply have the new words printed and at the bottom indicate which popular tune to 
use. 

Farewell to Old Ireland - Some of the best anti-war songs are Irish. The Irish constantly found 
themselves conscripted into an army in which they had no stake. So they fought with the British, but felt 
none of the glories of victory. They saw and felt the agony of war and sang about it. This song is that of an
Irish recruit in the British army and his journey to America to fight the Boys of Liberty.

Soldier, Soldier, Will You Marry Me? - This was originally a British song in the French and 
Indian War but it had great appeal to the ragged colonials during the Revolution. Our troops, with their 
tattered coats and ill fitting trousers, made a motley presentation. The American army could barely feed 
the men let alone clothe them. Conditions were so bad and the army so demoralized that desertion was 
not uncommon. At Morristown in 1781, there was a mutiny of the Pennsylvania line followed by others in 
the ensuing months. At one point 1,500 troops marched to Philadelphia to present their grievances before
Congress. It truly must have been difficult trying to survive the severe winters of those years. But they 
wrapped their rags around themselves and persevered. This ditty reveals their sense of humor about their
scarecrow demeanor.

Dog and Gun - Music was used in all facets of military life. A fifer and drummer helped the 
muster captain garner new recruits. On the battlefield, noisy and choked with smoke, a fife tune could tell 
you whether to advance or retreat. Camp life was often dominated by the music. There were tunes that 
told you when to waken, when to eat, when to sleep. Doubtless the fife was not always music to their 
ears! Military tunes helped keep up the soldier's pace and spirit on the march. A tune like Dog and Gun 
could inspire the weary troops to rise above their fatigue and carry on.

Massachusetts Hop - The hammered dulcimer is an ancient instrument with its roots in second 
century Persia. It has been played in many different cultures throughout the ages, and in the Colonies its 
bright, bell-like sound was popular for dance music. 

What a Court Hath Old England - Down Derry Down was originally a British tune. The 
Americans stole it and put their own words to it and there ensued a battle of the songs during which both 
sides put out several broadsides to the tune attacking each other. An angry young man in Boston penned 
these words in 1775 in response to tax on tea and British encroachment on Colonial fishing rights in the 
north Atlantic. It represented a radical sentiment for its time; calling for immediate independence and for 
any Englishman who gets in the way to be hanged from the Liberty Tree. The names in the first verse, 
Chatham, Camdem, Burke, etc. were members of Parliament who were sympathetic to the Colonial 
cause.

The Derby Ram - George Washington never claimed to have much musical ability. In a fan letter 



to Francis Hopkinson praising the author's latest songs, he wrote, I can neither sing one of the songs, nor 
raise a note on any instrument. But he loved music and this ancient nonsense song was reputedly one of 
his favorites.

Buttermilk Hill - Since time began men have been going off to war and women have been left 
behind to wait and wonder. This song comes from Ireland where the red dress was a symbol of 
faithfulness. The refrain was originally Gaelic, meaning come away with me, my love. When the song got 
to America in the 1750's it sounded like nonsense and that's just what it became. Sung especially in the 
Hudson River Valley during the Revolution, it expresses deep feelings of yearning and loneliness that are 
common to human experience in every century.

The Road to Boston - The alliance between the Colonies and France during the Revolution had 
dividends beyond military and moral support. French dancing masters swarmed into the Colonies and set 
up classes in the towns and villages, schooling young ladies and gentlemen in the latest dances. Their 
influence was strongly felt not only through the gentility and culture they brought to the Colonies but in 
their introduction of the quadrille -- a dance for four couples that was to become the American square 
dance.

In the Good Old Colony Days - It's a rare folk song whose origin can be dated to a very specific 
time, but this might be one of them. An earlier version of this song began, In good King Charles' day when
we lived under a King. Since there were only eleven years in British history that England had no monarch 
we can guess that this song springs from that period in the 1600's of Parliamentarian Rule under 
Cromwell. Once in America, the first line was changed and we have a merry, irreverent drinking song that 
spans two continents and four centuries.

Brandywine Quickstep - During the Revolution dances were composed to celebrate battles and 
military heroes: Burgoyne's Defeat, Clinton's Retreat, The Green Mountain Volunteers, and this sprightly 
tune, The Brandywine Quickstep. The title is probably a reference to the Continental Army's hasty retreat 
from the battle of Brandywine.

Hangman - In the 18th century England it was nearly a capital offense to be poor, and hanging 
was a common remedy. The gallows was the answer to a host of crimes, no matter how minor. Details 
have been lost over the decades, and therefore we don't know what this particular young lady did to find 
herself in this intense predicament. We do know that she had a very unpleasant family!

The Water is Wide - The plaintive melody and bittersweet sentiment have made this one of the 
best known and best loved of the old English songs.

For more information, see:
Bobby Horton 
Civil War Songs 
Linda Russell 



Broadsides
Broadsides were topical songs containing anything from the latest news to political ideas and propaganda
written for popular tunes and sold for two pennies a sheet on the streets.



Close Menu Button
Click this button to close a map legend. 



Open Map Icon
Accesses a list of existing maps from which you can select a map to open.



Close Map Icon
Closes the map in the active window. 



Copy Map Icon
Copies the map in the active window to the Windows Clipboard.



Slide Show Icon
Plays the slide show associated with the current map.



Overview Article Icon
Displays the Overview article associated with the current map.



People Article Icon
Displays the People article associated with the current map. If there is more than one People article 
associated with the map, the program displays a list. You can click on any name to open a brief biography
of that individual.



Document Article Icon
Displays the Document article associated with the current map. If there is more than one Document article
associated with the map, the program displays a list. You can click on any item to access the text of that 
document.



Search Icon
Opens the Place/Names dialog where you can view a list of items associated with the current map (or 
other maps), select an item to add to the map, and perform various other search and display tasks.



Arrow Cursor Icon
Activates an arrow cursor you can use in several ways, such as to select an item, resize a graphic on a 
map, or calculate the distance between two or more points on a map.



Hand Cursor Icon
Activates a hand cursor you can use to move map items and graphics.



Print Map Icon
Accesses the Print dialog where you can enter the desired print settings and print the current map.



Legend Icon
Displays or hides the map legend.



Edit Map Item Icon
Allows you to edit a selected map item to change the name, icon, or article attached to it. You can also 
modify display characteristics and change the item's location.



Edit or Create Map Graphics Icon
Displays/hides the graphics Toolbox.



Zoom Icon
Accesses the Zoom feature where you can set the zoom level for the map. If you have an area selected 
on the map, clicking this button zooms in on the selected area only.



Help Icon
Accesses online Help for information on program operations and product support, as well as information 
about American History Explorer and the Settings dialog box.



Open Article Icon
Accesses a list of existing articles (the Select Article dialog box). You can scroll through the list and 
double-click on any one to open it.



Close Article Icon
Closes the article in the active window. 



Copy Article Icon
Copies the open article to the Windows Clipboard.



Find Word Icon
Opens a Find dialog so you can pinpoint any word of text in the open article.



Previous Linked Article Icon
Accesses the last article in a series of linked articles that you viewed. 



Next Linked Article Icon
Accesses the next article in a series of linked articles that you viewed previously.



Print Article Icon
Prints the open article.



Font Icon
Opens the Font dialog box where you can modify the font of text in all articles or customize selected text 
in the current article by making it bold, italic, or underlined.



 Print Setup Dialog Box

This dialog box appears when you select Print Setup from the Map menu of a Map window or from the 
Article menu of an Article window (if you're using the Read/Write installation option). You can also access 
this dialog when you're using the Read Only installation option by clicking the Print Map (or Print Article) 
icon from the icon bar.

The Print Setup dialog box allows you to identify or change the printer (and its settings) that you use to 
print your maps and/or articles.

By default, the printer used for printing American History Explorer items will be the printer you have 
selected in the Windows Control Panel. However, you can choose any other printer you have installed to 
run with Windows.

To identify or change your printer, 

1. Accept the printer indicated in the Default Printer box or 

Click the down arrow at the end of the Specific Printer field to view your options and choose a 
printer. (To install additional printers, see your Windows manual.)

2. In the Orientation box, click Portrait to print in a vertical format, such as a letter. Click Landscape 
to print in a horizontal format. 

3. Choose the paper size and source by first clicking on the scroll button to display a list of options, 
then clicking on the item you want.

4. Click the Options button to specify other Windows printing options such as the type of dithering 
and intensity. Your choices will vary, depending on the printer you have selected. For more 
information on these options, click the Help button in the Options dialog box or refer to the 
manual for your printer. 

For more information, see:
Printing    
Moving Text to Word Processors    



Read Only 
One of the file attributes used by MS-DOS to identify a file and control the kinds of tasks you can perform 
with the file. A read-only attribute prevents a file from being changed. It differs from a Read/Write file 
which CAN be changed. Refer to your Microsoft Windows User's Guide for more information.For more 
information click on Installation Options. 



Read/Write 
A designation for a file indicating that you can both read the data and change (write over) the data. It 
differs from a read-only file, which can NOT be changed. Refer to your Microsoft Windows User's Guide 
for more information. For more information click on Installation Options. 



Dithering
Dithering indicates the degree of resolution or fineness of lines in a printed object or text. An object with 
no dithering will be black and white, with no shades of gray. 



Intensity
Degree of lightness or darkness of printed text or objects.



 Arranging Graphics

If you want to place certain graphics on top of others, you can do this by using the Top button on the 
Toolbox.

To place one graphic on top of the other:

1. Select the desired graphic.

2. Click the Top button on the Toolbox. The desired graphic will be placed on top of all the graphics it
overlaps.

For more information see:
Inserting Graphics into a Map 
Selecting Graphics 
Copying Graphics 
Moving Graphics 
Deleting Graphics 
Resizing Graphics 
Reusing graphics with the Add Graphics dialog box 
Drawing Lines 
Drawing Shapes 



 Program Tour

The first time you run American History Explorer, (and every time until you change the settings), the 
program will present a musical introduction followed by a Program Tour. This five-minute tour provides an 
overview of American history, followed by a brief description of the features included in the program.

You can interrupt the Program Tour at any time by pressing any key on the keyboard. A dialog will appear,
asking whether you want to finish viewing the Program Tour. If you click Yes, the Tour will continue where 
it left off. If you click No, another dialog appears, asking if you want the tour displayed every time you run 
the program. If you wish to see the tour the next time you start American History Explorer, click Yes. 
Click No to disable the feature.

You can also disable the Program Tour (and the opening video) by removing the X from the appropriate 
check box in the Settings dialog box. 

For more information, see:
Settings Dialog Box 



 Product Support Contents
Thank you for purchasing American History Explorer for Windows. The first thing you'll want to do is 
Register   American History Explorer for Windows  .

Parsons Technology addresses customer needs and concerns in two departments:

If you are having a problem operating the American History Explorer program, there are a variety of 
options available to help you resolve your difficulty. The Trouble Shooting Procedure includes a list of 
steps you should follow before contacting Parsons Technology to resolve any problem(s) you may have.

The Problem Report is the form you should complete before contacting Parsons Technology's Technical 
Support Department, in the event you are unable to resolve your difficulty and need further assistance.

For more information see:
Registering   American History Explorer for Windows   
Purchasing Other Products from Parsons Technology 

To return to the main screen of the American History Explorer online Help, see:
Help Contents 



 Trouble Shooting Procedure
Whenever you encounter a problem with the program or have a software-related question, follow this 
procedure:

1. Access American History Explorer's online Help (F1). This system presents operational 
information and is often context sensitive, reflecting a topic related to your current location and 
function.

2. Refer to the Information Guide you received with your program package and the contents and 
index within the Online Guide for specific topic and page numbers.

3. Refer to any README file included on your program disk. This file contains current information 
about American History Explorer.

4. Use an automated service to get help. See the When You Need Help section at the front of your 
User's Guide for details or click on these topics:

CompuServe Information Service
GEnie

5. If you still cannot resolve your problem, contact Parsons Technology's Technical Support. 
However, before you contact Parsons Technology, please fill out the Problem Report form. This 
will save you time on the telephone and is especially helpful if you cannot be at your computer 
when you call. Additionally, a technician may ask you to send this form.

To display the Problem Report form, click the button below. When the form appears, choose Print Topic 
from the File menu at the top of the window to print it.

For more information see:
Product Support - Customer Service and Technical Support    
Problem Report 
Registering   American History Explorer for Windows   
Purchasing Other Products from Parsons Technology 

To return to the main screen of the American History Explorer online Help, see:
Help Contents 



Problem Report

Please print and complete this form BEFORE contacting Parsons Technology for Technical Support. To 
print the form, choose Print Topic from the File menu at the top of the window.

Registered Customer Information

Customer #:                                                      Today's Date:                                                      

Name:                                                                                                                                                 

Address:                                                                                                                                           

City/State/Zip:                                                                                                                             

Day phone: (              )                                    FAX number: (              )                                   

Program Specific Information

Program and version:                                                                                                                   

Date ordered:                                                  Date replaced:                                                 

Please answer the following questions:

1. Was there an error code or message?                              (        )Yes                (        )No

If yes, please indicate the number and message including error address and 

file name (if any).

Code #:                                    Message:                                                                                 

2. Is the computer locking up?                                              (        )Yes                (        )No

3. Any problems installing?                                                    (        )Yes                (        )No

Comments:                                                                                                                                   

4. How is the program being installed?

            ____from 3.5" disk        ____from 5.25" disk            ____from compact disk (CD)

5. Did you use the DISKCOPY command on the original disks(s)?

                                                                                                    (        )Yes                (        )No

Did any error messages occur?                                          (        )Yes                (        )No

If yes, copy the messages here:                                                                                       



If no, make a DISKCOPY of all original disks to be certain the program is 

not caused by a defective disk.

6. Can you duplicate the problem at will?                        (        )Yes                (        )No

On a separate sheet, please describe the specific problem and what 

solutions you tried. In addition, list the steps which duplicate the 

problem (if known). Add any other comments you feel are helpful.

System Profile

Please supply the following system information.

1. Computer brand/model (check one):

      ___ PC XT              ___ PC AT              ___ 386              ___ 486              ___ Other PC

2. DOS version and manufacturer (type VER at prompt):                                                  

You can find the information required for questions 3, 4, and 5 by choosing 
Help Menu from the Windows Program Manager, then About Program Manager.

3. Windows version:                                                                                                                      

4. Operating mode (check one):                    ___Standard                        ___386 Enhanced

5. Free memory and system resources:                                                                                   

                                                                                                                                                      

6. Other programs that you have running:                                                                           

                                                                                                                                                      

7. We may need the contents of the files listed here. Please transmit the
information or have a printed copy in front of you when you call:

CONFIG.SYS
AUTOEXEC.BAT
WIN.INI
SYSTEM.INI

8. Printer model (if necessary):                                                                                           

9. Floppy drive size(s):                                                          ___ 5.25"                ___ 3.5"    ___ CD

10. Monitor brand and model:                                                                                                     

11. Type of graphics card:          ___ HERC      ___ CGA      ___ EGA      ___ VGA      ___ MDA

___ Other (state type):                                                   

12. Amount of available memory (CHKDSK C: at prompt):                                                   

Bytes available on disk:                                                                                                     



Total bytes memory:                                                                                                               

Bytes free:                                                                                                                               

XMS memory (MEM at prompt):                                                                                              



 Registering American History Explorer for Windows

When you purchase any product directly from Parsons Technology, you are automatically registered in 
our customer database. Therefore, you do not need to send in a registration card. Registration entitles 
you to the following registered customer benefits:

Free, unlimited technical support for current versions of all our programs.

Notices of updates to current products.

Announcements of new products.
If you purchased this product through a distributor, be sure to complete and return the customer 
registration card included with your packet. If you've misplaced the registration card, just click on the 
Display Form button below for a replacement. When the form appears, choose Print Topic from the File 
menu at the top of the window to print it.

You may also register your product by calling 1-800-847-6995 or faxing the registration card to us at 1-
319-395-7449. Contact us at these same numbers with any address changes so that we can keep you 
current with Parsons Technology developments.

For more information see:
Product Support - Customer Service and Technical Support
Problem Report 
Purchasing Other Products from Parsons Technology 
Parsons Technology Product List 

To return to the main screen of the American History Explorer online Help, see:
Help Contents 



Parsons Technology Product Registration
We make it easy to register your product with three convenient methods:

Call 1-800-847-6995 

Fax 1-319-395-7449

Print this form and mail it to: 

Parsons Technology Registration 
One Parsons Drive 
PO Box 100 
Hiawatha, IA 52233-9905 

Name                                                                                                                                                                                    

Address                                                                                                                                                                              

City                                                                                                      State                Zip                                          

Day Phone (            )                                          Evening Phone (          )                                        

Preferred disk size: [      ] 3.5" or [      ] 5.25"    or [      ] CD

If you are registering a Windows product, do you need 5.25" media? 

[      ] Yes      [      ] No

Which of the following best describes you? (please check one) 

[      ] I do not own Microsoft® Windows. 

[      ] I own and use Microsoft® Windows. 

[      ] I own Microsoft® Windows but don't use it. 

Software use: (please check one)    

[      ] I buy software for home use. 

[      ] I buy software for business use. 

[      ] I buy software for both uses. 

Product Code: AMHSC



 Customer Service
At Parsons Technology, you--the customer--are first. If you need help with any of the following, please call
our Customer Service Department at 1-319-395-0115 or fax us at 1-319-395-0466. A friendly 
representative will be happy to help you.

Questions or problems about your bill.

Defective user's guides.

Questions or problems about your shipment.

Questions about returning a product.

For more information see:
Problem Report 
Registering   American History Explorer for Windows   
Technical Support 
Purchasing Other Products from Parsons Technology 
Parsons Technology Product List 

To return to the main screen of the American History Explorer online Help, see:
Help Contents 



 Technical Support

Registered customers get free technical support for current versions of all our products. (See Registering 
American History Explorer for Windows for information on registering.) We offer phone support that is 
best used for getting you up and running. In depth and on-going support is mainly and best provided via 
CompuServe and other online services, as detailed below. Because of time delays associated with 
corresponding by mail, we do not accept written correspondence.

Note: If you're hearing-impaired or have other physical disabilities that affect your communication, please 
mention this in your correspondence along with the method by which you prefer for us to respond to you.

Also use Technical Support to replace any defective disks.

Before you contact us for technical support ...

Have you checked the User's Guide, the online Help, and the README file supplied with the 
software disks for possible solutions?

Can you duplicate the problem at will? Please try to repeat the steps that initially caused the 
problem.

Have you tried booting with a system-formatted DOS disk and running the program? See your 
DOS manual if you need help formatting a system disk.

Print and complete the Problem Report 

If you are unable to resolve the problem after checking the above items, please contact us by one of the 
following methods rather than by mail: 

The best way to get help quickly is to talk to us on CompuServe Information Service.

GEnie provides same-day response.

Another good way to get help is to use the Telephone

SmartFax gives you even more information.

For more information see:
Customer Service 
Registering   American History Explorer for Windows   
Purchasing Other Products from Parsons Technology 

To return to the main screen of the American History Explorer online Help, see:
Help Contents 





 Purchasing Other Products From Parsons Technology
Parsons Technology offers a full line of quality products, including our popular geneaology program 
Family Origins and new CD versions of our best-selling Bible study aids: QuickVerse Home Bible 
Study Collection and QuickVerse Bible Reference Collection. The Study Collection includes a 
complete online Bible with two translations, a topical index, and a Bible dictionary. The Reference 
Collection adds Strong's Concordance with Hebrew and Greek dictionaries and PC Bible Atlas, a 
computer-based atlas of the historical-geographical regions, cities, and countries found in the Bible.

In addition to these fine products, be sure to check out It's Legal, the program that generates wills, 
contracts, and other legal documents, and Golf Digest's ScoreCard for Windows, the program that lets 
you analyze virtually every part of your game! Click here to view a Product List.

To order Parsons Technology products, visit your local software retailer or contact our Orders Department 
toll-free 24 hours a day at 1-800-223-6925. Outside North America, call 1-319-395-7300. All our products 
come with an unconditional, money-back guarantee. If you're not satisfied with a program or our service, 
simply return your package within 30 days for a full refund (excluding shipping).    No questions asked!

Our order line staff are eager to help you, but they are not trained in the mechanics of our software. 
Please do not call them with technical support questions. They cannot transfer your call to Technical 
Support.

You can order products using online services, too. To shop using CompuServe Information Service, type 
GO PA. If you use GEnie, type PARTECH. You can also place orders using Delphi.

For more information see:
Product Support - Customer Service and Technical Support 
Registering   American History Explorer for Windows   

To return to the main screen of the American History Explorer online Help, see:
Help Contents 



 Parsons Technology Product List
These exciting software packages are also available from Parsons Technology. To order any program, or 
to receive a catalog of available products, call 1-800-223-6925.

Address Book for DOS or Windows - Forget crossing out old addresses and searching for 
scraps of paper, Address Book keeps track of all your addresses and phone numbers.

American History Explorer - A multimedia showcase of early American history including 
more than 100 narrated slide shows, six videos, 28 songs of the Colonial and Civil War 
periods, plus 1,300 articles, 1000 pictures, 100 3D pictures (and stereo viewing glasses), 93 
maps, an educational game and an easy-to-use, point and click interface.

Atomic Clock - Synchronize your PC! Atomoic Clock sets your PC's internal clock with 
atomic precision by dialing the time services of your choice.

Bible Illustrator for Windows - More than 2,500 thought-provoking stories, quotes, and 
anecdotes to enliven your Bible messages.

Calendar Works for Windows - A comprehensive personal information manager with 
calendar design features and much, much more.

Car Buyers' Companion for Windows - Shop for a new model car on your PC! Packaged 
with Home Buyers' Companion.

Crosswords Plus for Windows - Introducing Crosswords Plus--the two-in-one program that
gives you 100 puzzles and helps you create your own! A great teaching tool!

Daily Journal for Windows - Keep track of everything that happens in your business or 
personal life with this fun and-easy-to-use program.

Diet Analyst for Windows - Simpliefies the task of managing your family's health by 
analyzing the foods you eat, and keeps track of nutrients, cholesterol, exercise, and calories.

Education Planner for DOS or Windows - Make sure higher education stays within 
reach! Packaged with Retirement Planner.

Fabulous Fonts for Windows - 100 True Type fonts that will make your cards, posters, 
letters, memos, and presentations sizzle!

Family Origins for DOS or Windows - This complete genealogical program allows you to 
record and chart your family history for future generations.

Form Creator for DOS - The best way to produce professional-quality custom forms for 
businesses, homes, schools, and organizations.

Garden Planner for Windows - This start-to-finish planning tool lets you easily design a 
custom garden with your computer.    Choose the plants you'd like to include and get 
information on planting, germination, harvest times, and more!

Golf Digest ScoreCard for Windows - Track every round and know your latest handicap 
with this exciting program!

Holman Bible Dictionary for Windows - Enhance your understanding of every person, 



place, and event in the Bible with the Holman Bible Dictionary for Windows.. Search by 
topic or Bible reference to find exactly what you're looking for.

Home Buyers' Companion for Windows - Find out what size mortgage you can afford 
and avoid surprises at closing time. Packaged with Car Buyers' Companion.

Image Packages for DOS or Windows - Full-color graphics to add pizzazz to your cards, 
posters, and banners (print in shades of gray on black-and-white printers).

Interest Vision Professional for Windows - Powerful, easy-to-use tool for calculating and
comparing loan and investment options.

It's Legal for DOS or Windows - Protect your family and everything you own with valid 
wills and other legal documents. 

Medical Drug Reference for DOS or Windows - Gain instant access to critical 
information on more than 6,000 prescription and non-prescription drugs!

Membership Plus for DOS - The record-keeping software designed for churches, service 
groups, and more! Makes it easy to organize records, update membership lists, and track 
contributions.

MoneyCounts 9.0 for Windows - Control your personal and business finances with 
bookkepping accuracy and PC simplicity!

PC Bible Atlas for DOS or Windows -Colorful, detailed maps of the biblical holy lands 
with text describing historical events.

Personal Advocate - Address database and letter templates help you make the 
government, credit bureaus, and businesses work for you.

Personal Chef - The convenient way to collect and create all your favorite recipes. This 
database program comes with a large collection of recipes that you can modify or add to, 
laying the groundwork for your electronic cookbook.

Personal Home Inventory - Track important information about all your valuable 
possessions, including purchase and warranty information, credit card data, insurancy 
policies, maintenance schedules, and more!

Personal Tax Edge for DOS, Windows, or MacIntosh - An "excellent value" and easy-to-
use tool for preparing and filing your federal income taxes. 

Personal Tax Edge Preparer's Edition - An expanded version of the popular personal 
edition, designed for professionals who prepare returns for other tax payers.

Plain-Language Law Dictionary for DOS or Windows - Never be stumped by legal 
mumbo-jumbo again!

ProCalc 3D for DOS - ProCalc has more than 100 built-in functions, a powerful macro 
language, password protection, database capabilities, and more!

QuickVerse for DOS or Windows - Powerful online concordance for Bible study, 
comparison, and research. Choose from eight different Bible translations. (Extra translations 
sold separately.)



Resident Expert for All Versions of DOS - Never be stumped by DOS again! This online 
reference guide puts everything you need to know about DOS--including DOS 6.0--at your 
fingertips!

Resident Expert for Effective Writing - A comprehensive writer's reference, this program
gives you a helpful writing style guide, an almanac of useful facts and figures, and a 
handbook that give you correct syllable division for about 20,000 words. 

Retirement Planner for DOS or Windows - Plan now to keep your retirement years truly 
golden! Packaged with Education Planner.

Screen Dreams for Windows - This screen saver changes your computer monitor into a 
gallery of beautiful photographs depicting the theme of your choice: Holy Lands, Golf Digest,
or Spectacular Adventures!

Super Sketch for Windows - Unleash your creativity with this powerful, easy-to-use 
drawing program! Super Sketch puts a fully array of shapes, symbols, colors, patterns, and 
borders at your fingertips to create charts, flyers, graphs, diagrams, and much more!

The Information Please Almanac Series for DOS or Windows - These unique reference
tools put volumes of information right on your computer screen. Choose from The 
Information Please Almanac or The Information Please Business Almanac and Desk 
Reference.

ViruCide Plus for DOS or Windows - Protect your PC from more than 3,000 known and 
unknown viruses with this comprehensive protection package.

Wordquest for Windows - Wordquest gives you two exciting word games in one program! 
You can play the same puzzle two ways--either circle words in the classic WordMaze letter 
grid or play fill-in-the-blank with the challenging WordTangle puzzle. You can even create 
your own puzzles!

For more information on these and other Parsons software products, call 1-800-223-6925 
(outside North America, call 1-319-395-7300) or see your local software retailer.

To return to the main screen of the American History Explorer online Help, see:
Help Contents 



Defective Disk Replacement
Usually you receive one of these messages if you have a bad disk:

"General failure error reading drive ..."

"Sector not found ..."

"CRC error ..."

"Bad sector ..."

"Unrecoverable read error ..."

"Address mark not found ..."

To check, use the DISKCOPY command to copy the entire disk. DISKCOPY reports any bad sectors. 
(See your DOS manual.) Check all disks. To replace defective disks, call Customer Service at 1-319-395-
0115. Within 30 days of purchase, we replace disks free. After this, contact Customer Service for prices. 



CompuServe Information Service
If you are a CompuServe member, type GO PARSONS at any menu prompt. Select the forum and 
complete the Problem Report found in the Miscellaneous Info. library (file name: SYSPRO.TXT) or in the 
back of your User's Guide. We do our best to respond to questions within 24 hours in the forum only.

You may also discover that many of your questions have already been answered. You can tap into our 
library of application bulletins and other information releases. You can participate in a progressive dialog 
with experts and other helpful users.

If you would like to receive a free introductory membership to CompuServe, call CompuServe's Telephone
Sales and Inquiry Department at 1-800-848-8199 and ask for Representative #194. (You'll also need a 
telecommunications program and a modem.)



GEnie
If you prefer, you also can reach us on GEnie. Parsons Technology can be found in the IBM RoundTable, 
under Category 31, and in Software Library Section 10. You can leave your messages in Category 31 
under topics for each of our products. We check GEnie once each working day, so your question will be 
answered in approximately 24 hours.



Telephone
The Technical Support Department's voice number is 1-319-395-7314.

Before you call, make sure your computer is turned on and the relevant program running (if possible). 
Have the completed Problem Report at your fingertips.

An automated attendant will direct you to the right location and give Technical Support Department hours. 
We are a service-oriented company and will take all the time needed to answer your questions. But when 
you first dial in, you may have to wait a short time while we offer this same attention to the callers ahead 
of you.



SmartFax
Parsons Technology also maintains a SmartFax system which lets you receive technical bulletins, product
descriptions, and other information about our products automatically. Just call from your own FAX 
machine. The SmartFax number is 1-319-395-0176.

The system will answer with a voice and will ask you which document you would like to receive. Choose 
document 100 for instructions for using the system and a partial directory of available information. Choose
101 for a complete directory. The item you choose will be sent directly to your FAX machine. This service 
is available 24 hours a day. You must call from a FAX machine. 




